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Software Licence Agreement 
WestDev Ltd and Number One Systems 

This document contains the WESTDEV LTD SOFTWARE LICENSE AGREEMENT which will govern 
the use of the Westdev and/or Number One Systems’ products supplied with it. You agree to the terms of 
this agreement by the act of opening the sealed package which contains the storage media on which the 
software is recorded. Do not open the sealed package without first reading, understanding and agreeing 
the terms and conditions of this agreement. If you do not agree to the license conditions you may return 
the SOFTWARE for a full refund before opening the sealed package.  
1. LICENSE AGREEMENT 
Ownership of the WESTDEV / NUMBER ONE SYSTEMS’ Software Package and all its constituent parts 
supplied by Westdev Ltd ("LICENSED SOFTWARE") is not transferred to the Customer. Westdev Ltd 
hereby grants you, the LICENSEE, a non-exclusive license to have, at any time, as many copies of the 
LICENSED SOFTWARE “in use” as you have Licenses. The number of copies “in use” includes copies 
loaded into computer memory (i.e. “running”) but does not include copies loaded in a network server for 
the sole purpose of distribution to other computers. LICENSEE shall agree to have a reasonable 
mechanism or process in place to ensure that the number of persons using the LICENSED SOFTWARE at 
at any time does not exceed the number of Licenses granted to you. 
2. OWNERSHIP OF SOFTWARE 
As the LICENSEE, you own the magnetic, optical or other physical media on which the LICENSED 
SOFTWARE is originally or subsequently recorded or fixed, but an express condition of this License is 
that Westdev Ltd and/or the copyright owner retains title and ownership of the LICENSED SOFTWARE 
recorded on the original media and all subsequent copies of the SOFTWARE, regardless of the form or 
media in or on which the original and other copies may exist. This License is not a sale of the original 
SOFTWARE or any copy. 
3. COPY RESTRICTIONS 
This LICENSED SOFTWARE and all accompanying written materials and all other constituent parts are 
the subject of copyright. Unauthorised copying of the LICENSED SOFTWARE, including software 
which has been modified, merged, or included with other software, or of the written materials is expressly 
forbidden. You may be held legally responsible for any copyright infringement which is caused or 
encouraged by your failure to abide by the terms of the License. 
4. TRANSFER OF LICENSED SOFTWARE 
The Customer may transfer the LICENSED SOFTWARE provided that (i) this Software License 
Agreement is transferred with the LICENSED SOFTWARE, (ii) the transferee fully accepts the terms and 
conditions of this Agreement, and (iii) all complete or partial copies of the LICENSED SOFTWARE, 
including copies on data storage devices are also transferred (or destroyed). 
5. MODIFICATION 
You may not otherwise modify, alter, adapt, merge, de-compile or reverse-engineer the LICENSED 
SOFTWARE, and you may not remove or obscure any Westdev Ltd and/or Number One Systems' 
Copyright or Trademark notices. You must use all reasonable efforts to protect the LICENSED 
SOFTWARE, diskettes, and documentation from unauthorised use, reproduction, distribution or 
publication, or otherwise in violation of applicable law. Please contact our Customer Service department 
if you become aware of violations of Westdev Ltd's Copyright. 
6. TERMINATION 
The License is effective until terminated. You may terminate it at any time by destroying the LICENSED 
SOFTWARE and all complete or partial copies thereof. It will also terminate if you fail to comply with 
any term or condition of this Agreement. You agree upon such termination to destroy the LICENSED 
SOFTWARE and all complete or partial copies thereof. 
7. WARRANTIES 
No warranties are expressed or implied with respect to the LICENSED SOFTWARE described, its 
quality, performance, accuracy or suitability for any purpose. In no circumstances will the copyright 
holder be liable for direct, indirect, incidental or consequential damages resulting from the use of this 
SOFTWARE. 
8. OTHER SOFTWARE 
The supplied disks may contain software whose copyright is owned by third parties. This license 
agreement shall apply equally to this software except where the terms of this agreement are specifically 
modified by the copyright holder(s). Such modification(s) will be included in a machine readable file on 
the supplied media. 
9. GOVERNING LAW 
The Governing Law of this Agreement shall be that of England. 
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Chapter 1. Getting Started 

Welcome 
Stockit For Windows is a Stock Control and Production Planning 
system designed to give you the tools needed to manage your stores and 
production environments in a simple and effective manner. It is equally 
applicable both to ‘simple’ inventory control and to the management of 
the production of complex products. 

Stockit benefits 

Stockit For Windows (“Stockit”) is an easy to use product. All 
information about the components that you use and your suppliers is 
stored in a central industry standard database so you only have to enter it 
once. 

Creating a parts list for an assembly is then a simple matter of selecting 
how many of each component is required. There is no need to enter data 
more than once if, for example, a sub-assembly is used in more than one 
product. 

Sequence driven 
You have full control over the layout of parts lists, arranging the 
sequence and grouping of parts, inserting blank lines and descriptive text 
to make it clear and easy to use for both design and servicing purposes. 

The detailed descriptions of each component are taken from the central 
list of stock items ensuring consistency at all times. 

Minimal chance of error 
Stockit always attempts to present the information in the most 
appropriate way. A picking list is available for use in Stores areas and an 
Assembly list can be used by sub-contractors who need to know what 
type a particular component is and when it is used. 

These alternative views are produced from the original information thus 
avoiding potential errors that might otherwise be caused by the manual 
transfer of data. 

Manufacturing benefits 
Stockit also supports Costing, Bill of Materials, Trial Kitting, Shortages, 
Orders, Order Enquiries and Stock Control. All the features of Stockit 
operate in a hierarchical structure encompassing the way in which the 
product is constructed. 
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Financial benefits 
The monetary value of components and planned work can be established 
quickly. Sub-assemblies, full products and sub-products can be costed to 
give a true cost, including the ‘hidden’ costs of build time and test time. 

Network ‘aware’ 
Stockit is fully ’network aware’, and can be used in a true multi-user 
environment. A single, shared database can be accessed by many people 
at once, with all the security and peace of mind that comes through using 
a truly multi-user application. 

With a user interface that allows you to access all areas of the system at 
any time, and a comprehensive collection of reports that you can 
preview ’on screen’, you should find all the information you need is at 
your fingertips. 

Suggested reading 
Depending on the system (if any) you are currently using, different 
sections of this manual will be useful to you. Regardless of your current 
system, we recommend that you read the Installation section. 

New users 
We recommend that users new to Stockit start at the beginning and work 
their way through. This guide has been written to follow a logical path 
through the sequence of setting up, entering the data and using the 
system. Depending on the tasks for which you need to use Stockit, you 
may find you can skip certain sections if they are not relevant. Some of 
the topics in the ’advanced’ section may also not be needed. 

Stockit (DOS) users 
Users of the Stockit or Stockit Professional DOS-based products should 
start by reading the special section “Stockit Users” that details the steps 
you need to follow to move your Stockit data to Stockit For Windows. 

There are of course many new and enhanced features in Stockit For 
Windows over and above those that you have been using in Stockit. 
These too are summarised in the “Stockit Users” chapter. 

After this, you may find that it is useful read other chapters that you 
think might be relevant to how you want to use the program. 

Stockwin users 
We recommend that users of the Stockwin product read the section 
“Stockwin Users” so that you are aware of any issues related to 
migrating from Stockwin to Stockit For Windows. As with Stockit 
(DOS) products, there are important differences of which you should be 
aware before you make the move to Stockit For Windows. 
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After this, you may find that it is useful read other chapters that you 
think might be relevant to how you want to use the program. 

Other Systems 
If you have used another system, you can work your way through the 
manual. There is a section “Importing Data” which details the migration 
of data from other systems. 

Once your data is imported, you can then follow the manual through the 
introductory chapters as mentioned above for ‘New Users’. 

Finding information 
The contents of this manual 

This manual has been designed to guide you through the basic tasks 
involved in setting up and using your new Stockit software. Each chapter 
covers a particular area of the product, such as Stores, Financial and 
Production. There are also chapters detailing 'advanced' tasks, and 
information relevant to users of the Stockit and Stockit Professional 
products, and the Stockwin product. 

This manual is available in both printed and online form. The printed 
version will be useful if you would like to read it away from your 
computer, or if you simply prefer working from a printed book. The 
online version is implemented as a PDF format document, readable 
using an Acrobat ™ reader. This allows you to work through the guide 
on-screen alongside the Stockit application itself. The online version will 
also be needed when using the ‘demonstration’ version of the product, 
for example if you have downloaded a trial copy from the Internet. 

As well as this manual, a lot of information is provided in an online help 
system (available as HTML help). This help is accessed from within the 
Stockit program at any time by pressing the F1 key. 
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What the manual covers 
This manual covers the following areas: 

• Chapter 1. Getting Started 
introduction to the Stockit product and 
documentation. 

• Chapter 2. Installation and Setup 
installation of the product in various 
configurations. 

• Chapter 3. General Principles 
the basics involved in Stockit and how the 
product is used. 

• Chapter 4. The Quick Guide 
a short tour through some of the key features. 

• Chapter 5. The Tutorial Guide 
a more complete tutorial covering most areas of 
the product. 

• Chapter 6. Setting Up Your Own Database 
a guide to setting up your own Stockit 
information. 

• Chapter 7. Purchasing 
maintaining stock levels and interacting with 
suppliers. 

• Chapter 8. Parts Lists 
creating and managing parts lists. 

• Chapter 9. Production 
the production cycle from planning through 
ordering to build and completion. 

• Chapter 10. Finances 
accessing and updating financial information. 

• Chapter 11. Reports 
how to generate reports from Stockit. 

• Chapter 12. Advanced Tasks 
administration and maintenance of your Stockit 
system. 

• Chapter 13. Networking and Multi-user Configuration 
setting up and managing Stockit in a multi-user 
environment. 

• Chapter 14. Upgrading Your Existing System 
migrating from earlier stock control products or 
versions. 

• Chapter 15. Trouble-shooting  
solving common problems. 
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• Appendix A.  Glossary 
terminology used in the Stockit product and 
documentation. 

After the introductory chapters, the first part of the guide (Chapters 4 
and 5) is written in ’Tutorial’ style, guiding you through the basics of 
Stockit to help you get ’up to speed’ quickly, either to evaluate the 
demonstration version of the product or to get to grips with using Stockit 
’for real’ in your business. 

The second part of the guide contains information about more advanced 
topics, installation, networking and multi-user operation, and migration 
from earlier products. Some Stockit users will only need some of these 
chapters. 

Note: The ’Trouble-Shooting’ section in this manual only covers problems that 
may occur in trying to start the application. More complete trouble-
shooting or guidance is provided in the online help accessible from 
within the application itself. 

Document styles 
The following styles are used in this document: 

Programs Menu item, icon, button, command name or 
shortcut key 

<name> or “text” Places where you enter information (enter it 
without the <> brackets or “” double quotes) 

Online help 
As well as this Users Guide, comprehensive reference information is 
available in the form of context-sensitive online help within the 
application itself. Simply press the F1 key, or select Context Help from 
the Help menu, to access the online help for the current task, dialog or 
form. 

Note: The online help is only available once you have installed the software. 

Database overview 
Microsoft Access and Jet database engine 

Stockit For Windows has been designed and built around a Microsoft 
Access database, and is accessed using the Microsoft Jet database 
engine. You do not need a copy of Microsoft Access or the database 
engine to run Stockit, as all the files you need are included with the 
Stockit product and are automatically installed for you during Setup. 
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The information stored within the database is divided into ’tables’, each 
table containing one or more (and sometimes many) records. Various 
relationships are defined between these tables, which are used by the 
database engine to ensure that the rules defined in those relationships are 
not broken. 

For example, the relationship between the name of a supplier record and 
the supplier field of a stock record ensures that if the supplier name is 
changed, all stock items referring to that supplier will be updated to 
match. This feature ensures the continued ’integrity’ of your data. 

Important ‘queries’ or ‘searches’ are also stored within the database, to 
further enhance the performance when searching and processing large 
amounts of data. 

Database tables and field sizes 
There are some limits on the size of some fields in the database. For 
example, part numbers cannot exceed 50 characters. Please refer to the 
online help for more details on limits. 

Tutorial database 
The software installation includes a tutorial database, complete with 
examples of ‘real’ product data. You can use this database to experiment 
with the product features, safe in the knowledge that you cannot alter 
your 'main' database contents. You even can switch between the two 
databases at the press of a button. 

Although the tutorial database allows you to use all the features of the 
application, the size of the database is limited. The database is limited to 
75 stock records, 20 purchase orders and 10 production jobs. 

The tutorial database is used later on, in the tutorial chapters of this 
guide. 
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Chapter 2. Installation and Setup 

System Requirements 
Hardware required 

Before installing Stockit, please check that you have the following 
requirements including: 

Minimum requirements 
A Pentium processor level computer running one of the operating 
systems detailed below. At least 32Mb of memory (64Mb for Windows 
2000 Professional). 

Recommended requirements 

A Pentium processor level computer (230Mhz or greater) running one of 
the operating systems detailed below. At least 64Mb of memory (128Mb 
for Windows 2000 Professional). 

A hard disk with at least 20Mb of free space to install the product and 
have room for the database to grow. 

A SVGA or higher resolution graphics card running at least 800x600 
resolution. 

A mouse with 2 or 3 buttons. 

Supported operating systems 
Windows 95 

Windows 98 SE 

Windows ME 

Windows NT 4.0 Service pack 5 or later 

Windows 2000 

Windows XP 

Windows 3.x, MAC OS or Linux are not supported 
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Program security 
Stockit is protected by means of a security license that is unique to every 
customer installation. Without a valid license (product key code), the 
software can only be installed in demonstration mode. 

Installation overview 
Stockit supports installation for a number of different types of 
configuration. You can run Stockit in single user mode where the user 
and the database are on the same machine; in single user mode with a 
remote database (the database on a central server); and as multi-user 
where the database is stored on a central server or shared drive and with 
more than one user accessing it at a time. 

As part of the installation process, you will be asked to choose which 
type of installation you wish to do. The various options available are 
covered below. 

Important: If you are installing the ‘full’ product (not the demo), you will need to 
‘activate’ your installation using an ‘activation code’. Please see 
“Activation codes” on page 24 for details. 

HTML Help 
Stockit is supplied with the HTML on-line help system.  During 
installation the Setup program checks for the existence on your hard 
drive of the run time components for HTML help. If they exist already 
you can skip this page of Setup. You can opt not to install the HTML 
Help components during Setup but will be required to do so if you 
intend using the Stockit HTML Help. You will have to run the Stockit 
Setup again in order to install the required components. 

Following the successful installation of the HTML help components, the 
help system is ready to use without a system reboot being required. 

Installing a demonstration copy 
Alternatively, if you don’t have a Product Key at all, you can still install 
Stockit, but you will only be able to use it in Tutorial mode. This allows 
you to access almost all the features of the product, but the capacity of 
the database will be limited (to 75 stock components, 20 purchase orders 
and 10 production jobs). To install a demonstration copy, install as for 
‘Single/First User’ operation, and enter DEMO as the product key code. 

Updating from the Internet 
As well as major updates supplied on CD-ROM, Stockit may be updated 
from time-to-time to provide ‘service patches’. These will be available 
from our web site at http://www.numberone.com/stockit/updates
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Any service patches posted to this location will be available to users who 
have valid maintenance contracts with us. These patches will be 
automatically installed into the appropriate folder(s) once selected from 
our web site. Any changes to this procedure will be documented on the 
web site. 

Installing for single-user operation 
To install the software, we recommend that you first close all other 
applications, saving your work if necessary. This is actually a standard 
precaution you should take before installing any software product. 

Insert the CD-ROM into the CD drive and wait for a short time. The 
default setup of Windows includes an "autorun" facility that should 
detect the CD and start the Setup program. If your system has the 
autorun facility disabled, or it simply hasn’t worked, select Run from the 
Start menu, and type D:\setup.exe (replacing the D: with the actual CD 
drive letter if yours is different), then press the Enter key or press OK.

Double-click (click twice quickly with the left mouse button) on the 
‘Stockit for Windows’ entry in the list of ‘Installations’ on this opening 
screen. Or, click once on the entry and press the Enter key on the 
keyboard. 

The Setup Wizard will now guide you through installation of the 
software. Just follow the simple on-screen instructions to install the 
product.  

When prompted to choose the ‘installation type’, choose the 
‘Single/First User’ option: 
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You may choose to install the software or the database into a folder 
other than the default suggested during Setup. The Setup Wizard will 
prepare your system so that everything is set up correctly when you run 
the program for the first time. 

One screen in the installation wizard allows you to choose which options 
or parts of the product to install. Unless you have a particular need to do 
so (for example under the guidance of a technical support engineer), you 
would generally install all available options. 

Activating the product 

If you are installing the ‘full’ product, please refer to “Activation codes” 
on page 24 for details on how to activate your installation. 

Installing for multi-user operation 
Important: If you are going to use the software on a network or with 
multiple users, please be sure to read "Chapter 13. Networking and 
Multi-user Configuration" starting on page 133 before installing the 
product. 

Note: Multi-user operation is only available with the ‘full’ product, not with 
the demonstration version. 

There are several stages to installing for multi-user operation: 

• Install program files and database to central shared location 

• Install system files and prepare system on second and subsequent 
computers 

• Authorise database to allow multiple concurrent users (optional). 

The final stage above is listed as optional, because Stockit can be used in 
a multi-user configuration even if only licensed for single-user access. In 
this configuration, all users can access the same ‘shared’ database, but 
only one at a time. To set up your systems to work this way, follow the 
installation sequence shown below but leave out the step ‘Enabling 
multiple user access’. 
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Installing on the file server 
On the first computer, choose the ‘Single/First User’ option when 
prompted to choose the ‘installation type’. 

On the ‘Select Components’ screen, leave all options checked and 
continue to the next screen. 

The default settings will load the program files and database onto your 
local hard drive, so you will need to change these locations using the 
‘Application Folder’ and ‘Database Folder’ screens. 

To allow sharing of database information across multiple computers, you 
should choose folders for the program and database files that are 
accessible to all the people who need to use the program. 

Installing the other computers 
On the second and subsequent computers, choose the ‘Additional User’ 
option when prompted to choose the ‘installation type’. 

Selecting this option will prompt you to locate the program and database 
files that were installed on the file server. Your system will be prepared 
with the locations of these files so that you can access the shared 
program and database. 

Note: Certain system files (database drivers, etc) necessary to the operation of 
the program will still be installed on your local hard drive. 

Creating usernames and passwords 
To help you track who is using the system in a multi-user configuration, 
it is recommended that you create a separate username for each 
individual that needs to use the system. This is described in the section 
“User configuration” in “Chapter 13. Networking and Multi-user 
Configuration”. 

If you are going to enable multiple user access, you will need to create 
usernames, or at least check that the built-in ones are suitable. 

If you are using the system in a ‘single user shared database’ 
configuration (with only one user at a time logged in), it is 
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recommended that you still create usernames so that you can track who 
is using the system at any particular time. 

Requiring passwords at Login 
If you want your users to enter their password when they log in, you 
should set the checkbox ‘Users must have passwords’ on the “Login and 
Security” page. 

The other setting shown here, “Anonymous login”, should be cleared 
when running with multiple concurrent users. If this setting is ‘checked’, 
the login dialog will not require a username, and will log in with the 
default user “admin”. The next person to try and start the program will 
not be able to gain access to the database because “admin” is already 
logged in! 

Activating the product and enabling multiple user access 
If you are installing the ‘full’ product, the following section contains 
details on how to activate both your installation and the correct number 
of concurrent users. 

Although Stockit is a fully network-aware multi-user application, the 
default installation (even when installed on multiple computers as 
described above) only allows access to the database by one user at a 
time.  

Activation codes 
When initially installed, the product allows you to log into the database 
only a limited number of times until the installation is ‘activated’ using 
an ‘activation code’. 

Each time you start the program, you will be reminded that you need to 
activate the installation before the ‘usage’ count runs out. If the usage 
count does run out, you will only be able to ‘request an activation code’ 
as shown below, and won’t have access to other program options. 

Requesting an activation code 
Depending on how you purchased your product, you may find that this 
activation code is already included as part of the package. If not, you 
will need to request a code from Number One Systems. 

To do this, start the Stockit application from any of the computers on 
which you have installed it. Once the program starts, choose Options 
from the Tools menu (or press function key F9). Then select the page 
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called “Login and Security”. On this page, click on the Change button 
alongside the “number of concurrent users”. The dialog that opens will 
show you the serial number to use: 

Make a note of the serial number shown on your screen (not the one 
shown in the picture above), then contact Number One Systems to 
request your activation code. 

Installing your activation code 
The activation code you will be given will be 5 sets of 4-digit numbers. 
If you haven’t left it running, go to the same computer as you used for 
the ‘request’ procedure described above, start Stockit, choose Tools and 
Options, then “Login and Security”. 

Click on the Change button again. Now you will be able to enter the 
activation code in the lower part of the dialog: 

Enter the code in the boxes shown, and press the Activate button. 

Note: If you have received your authorisation code by email, and use Copy to 
copy it to the clipboard before opening the above dialog, the code will 
be entered in the boxes for you automatically. 

Setting up a printer 
Stockit is a fully Windows-compliant product. It runs on standard 
hardware using any Windows supported graphics drivers and printers. 
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As long as Windows supports it, so will Stockit. No special printer 
configuration is necessary. 

The forms and reports that Stockit generates are all configured to fit a 
standard A4 (UK size) width page. This means that the Letter size used 
generally in the USA will also fit, except for some Landscape reports as 
Letter is slightly shorter in length. 

Stockit will use any printer that you can normally print to from your 
other applications, either locally on your own computer or across a 
network. 

Upgrading from single to multi-user 
If you have a single user installation and wish to upgrade it to multi-user, 
you may first need to move the database file to somewhere that is 
accessible to all the computers and users that need to use it. This is 
described in the section “Moving the database” in “Chapter 12. 
Advanced Tasks”. 

Once the database is in a suitable shared location and working correctly 
with your currently installed copy of Stockit, you can follow the 
procedures listed above under “Installing for multi-user operation” (from 
“Installing the other computers” onwards) to prepare your systems for 
multi-user operation. You will need an activation code to actually 
change the number of users; the procedure for doing this is detailed in 
the section “Activation codes” on page 24. 

Uninstalling Stockit For Windows 
To uninstall the product from your hard drive you should use the 
Uninstall Stockit option. For product updates or upgrades you do not 
need to uninstall existing product first regardless of its version. 

X To uninstall Stockit 
1. Click on Start on the taskbar, click Programs, click on Stockit 

For Windows 

2. Click on Uninstall Stockit For Windows 

You are given a choice of confirming the uninstall or not. If you click 
Yes, Stockit will now be completely uninstalled from your local hard 
drive and any relevant settings removed from the registry. 

Distributor Sales 
If you have purchased this software package through one of our 
distributors or resellers, you must register the product with our sales 
office in order to qualify for 30 days technical support from our support 
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desk. The registration is only used by Number One Systems for 
qualifying eligibility of technical support and for keeping you informed 
and up-to-date about our products. Your details are not passed onto any 
other 3rd party or used for any other purposes. Support is not provided in 
any circumstances where the product has not been registered if bought 
through one of these channels. 

You may also need to ‘activate’ your product before using it; the 
procedure for doing this is detailed in the section “Activation codes” on 
page 24. 

Note:  Additional extended support schemes are available outside the 30-day 
warranty period. Please contact your local sales office for further 
information. 

Contacting Technical Support Resources 
On-line help 

For detailed information about the product and its features you should 
consult the on-line help system provided. The on-line help is being 
continuously updated not only with feature information but also 
procedures for creation of particular database elements. 

As a standard feature of on-line help an Index which is sorted 
alphabetically and Search facilities are provided to help with the location 
of information within the help system. Alternatively, every dialog and 
option has its own 'context' sensitive help which can be accessed using 
the F1 key or the Help button on a dialog.  

If you are unfamiliar with HTML help, you can learn how to use it by 
selecting the How To Use Help option from the Help menu once Stockit 
is running. 

Web site 
The web site (www.numberone.com) can be accessed at any time for up-
to-date information. This web site is a comprehensive source with a 
range of free support options and downloads available to you 24hrs a 
day, 7 days a week, which may include: 

• Technical information and product news 

• Practical stock and database organisational ideas 

• Frequently asked questions 

• Technical information 

• Training and seminar information 

• Patches and minor product updates for registered users 
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• Contact and information about consulting, support services, training 
and professional services available 

Technical support 
When your copy of Stockit is purchased, you are eligible for 30 days 
free technical support. The 30-day period begins from the date of 
delivery to you regardless of whether you install the product 
immediately or not. During these 30 days you will have access to our 
support engineers via the worldwide web, e-mail, fax and telephone 
(Monday to Friday from 10:00am to 4:00pm GMT in the UK. Outside 
this location please contact your local support centre or consult our web 
site. 

Contact details for technical support: 

• Web site: www.numberone.com/support.htm 

• Email:  support@numberone.com 

• Phone:  +44 (0) 1480 382538 

• Fax:  +44 (0) 1684 773664 

Support is limited to: Installation assistance and questions regarding 
Stockit usage, all answered in context of how to use the features. 
Questions regarding integration with other systems can only be 
answered broadly. You may be referred to our consultancy services for 
further assistance. Consultancy is available from Number One Systems, 
for more information about this service please contact our international 
sales office. 

After your free support has expired, extended support options can be 
purchased. Please refer to our web site page 
www.numberone.com/support.htm 

Whenever technical support is contacted, you will need to have the 
following information to hand: 

• Your name and the name of the registered user (if different) 

• Your contact details (phone, fax and E-mail address) 

• Your customer reference number 

• The product version number (located in the Help menu and About 
dialog) 

• A detailed description of the problem or question. If possible, detail 
accurately any error messages displayed and how to repeat the 
problem or conditions that lead to the problem. It also helps us and 
speeds up the process if a problem can be reproduced using the 
tutorial database supplied. 



Stockit Users Guide 29 

Chapter 3. General Principles 

Introduction to Stockit 
This chapter will give you a broad outline of the general principles of 
how to use the Stockit application. It covers how to start the program, 
the various parts of the user interface, and so on. 

Basic interaction 
Stockit is a ’true’ Windows application, and as such you will find that it 
behaves very much like your existing ’office’ applications. Standard 
Windows terminology is used wherever possible, and all the normal 
Windows menus, toolbars and shortcut keys will make it easy for you to 
get started with the software. 

This means that where items are found and used in most Windows 
applications that follow this standard, Stockit will also use this pattern, 
for example, Undo and Redo appear on the Edit menu that always 
appears on the right side of the File menu etc. 

You should familiarise yourself with the Stockit features by reading 
through this chapter, and working through the menus and options 
available. 

Starting the program 
Stockit is automatically added to its own program group that you have 
named during setup. You may also wish to add a shortcut to your 
desktop to facilitate the location and start-up of Stockit. 

X To start Stockit 
1. Click on Start on the taskbar (usually at the lower left corner of the 

screen), click Programs, click on Stockit For Windows 

2. Select Stockit For Windows, the Stockit application will then start. 

The start location of the program can be set using the Folders option on 
the Setup menu. Please refer to the Windows on-line help under item 
Properties if you are unsure on how to do this. 

Single-user ’automatic’ login 
When the software is first installed, login takes place automatically 
using the built-in username “admin”. The rest of this manual generally 
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assumes that you are the only user of the program. Where special issues 
arise in a multi-user configuration, these are mentioned in the text. 

When the main program starts, the upper part of the Login dialog is 
displayed briefly (showing you the current program version number) 
before it disappears and is replaced by the main application window. 

If you then change to a multi-user setup (as described above in 
“Installing for multi-user operation”), this automated login will stop and 
the normal Login dialog (as described below) will be displayed next 
time you start Stockit. 

Logging in 
The Login dialog allows you to enter your username. If your system is 
set up to require passwords too, you will be prompted to enter your 
password as well. Please remember that your password must be entered 
exactly as it was originally set up. Passwords are case sensitive, so you'll 
need to be especially careful about entering upper or lower case letters. 

Enter your username (and your password if required) and press OK. If a 
valid username and password are entered, the Login dialog will close 
and the main application screen will appear. Otherwise, an error message 
will tell you that the username / password combination you have entered 
is not correct. 

If passwords are enabled on your system, you can change your password 
form the login dialog by clicking on Change Password. The Change 
Password dialog is displayed: 

You will need to enter your current password first, and then enter your 
new password twice (to avoid accidental typing mistakes). Your 
password will be changed only if the old password is valid for the 
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username shown on the Login dialog, the two copies of the new 
password are identical, and the new password is itself a valid password. 

Note that you do still need to know your current password. This dialog 
does not allow you to side step the security and change the password if 
you don’t know the current one. 

Leaving the program 
You can leave the program at any time by selecting Exit from the File 
menu, or pressing the standard key combination Alt+F4. If you have any 
unfinished actions, such as adding or editing database records, you will 
be prompted to save or abandon these before the application closes. 

If you want to stop using the program, but leave it ready for someone 
else to start work, selecting Log Off from the File menu will ‘close’ 
your connection with the database, and leave the application running at 
the ‘Login’ dialog. 

The program interface 
When you run Stockit, the main application window appears. Stockit 
operates a multiple document interface (MDI), so you can open as many 
forms or reports as you like. 

The picture above shows each of the major framework features. Each of 
the items shown above is described in more detail later on in this 
chapter. 
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Menu options 
The menus on the menu bar are set out logically to be used as you move 
through the production cycle, starting from the left and moving right. Of 
course, you may only be using some of the capability of the product, so 
may not need to access all the menus. Regardless of how you work and 
where you start in your production cycle, you should find that the menus 
are logically arranged and therefore easy to use.  

Where possible we have used basic descriptive words on the menus for 
functionality. For example, to view the next record on a Stock form, you 
would select Next Record from the View menu. 

Tool Bar 
The Toolbar in Stockit contains ‘buttons’ for the most commonly used 
of the menu options. All the buttons on the toolbar are also available 
through the menus. 

Like the menus, the toolbar buttons are arranged into groups, and 
ordered in the same sequence as the menus themselves. 

When options are not available, the toolbar buttons (and the 
corresponding menu options) will appear ‘dimmed’ or ‘greyed out’ to 
indicate that these options cannot be applied. For example, some options 
only work on jobs that are at a particular stage in the production cycle. 

You can find out what each button on the toolbar does, by moving the 
cursor over the button and pausing until the small popup “tooltip” 
message appears displaying the name of the option. 

To help you arrange the screen to suit your preferred way of working, 
the toolbar can be set to be either 'Docked' or 'Floating'. Below is an 
example of a docked toolbar. The toolbar is docked below the Menu bar 
in the horizontal position. This is the default position, but it can be 
moved as required. 

In docked mode, a toolbar is fixed along any of the four borders of the 
main window ‘frame’ in either a horizontal or vertical position. You 
cannot modify the size of a toolbar when it is docked.  

Selecting the window border and ‘dragging’ it away from its current 
location can move the toolbar. By dragging it, it becomes detached from 
the window frame. When the toolbar is then moved over another area of 
the frame to which it can be attached, it changes shape to indicate that it 
can be docked there. You can also make it floating by Double-clicking 
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in the toolbar area itself (but avoiding the buttons which will select an 
option). 

The toolbar can also be floating. When floating, the toolbar is moved 
into free space and appears to ‘float’ over the main window. This toolbar 
can now be reshaped to make it fatter or thinner by dragging the outer 
edge in or out. The toolbar can be shaped to be one tool wide or long by 
as many tools as are loaded on the toolbar in the opposite direction. By 
selecting the outer edges of the toolbar a small arrow 'handle' will appear 
to indicate that the toolbar can now be reshaped. Drag the handle until 
you have the shape you require. 

You can restore the toolbar to its last docked position by double-clicking 
on the caption bar along the top of the toolbar. 

To move a floating toolbar, select and drag the toolbar caption. The 
toolbar will move dynamically with the mouse movement. Release the 
mouse button to release the toolbar. If you move it over one of the edges 
of the main window frame it will try and ‘dock’ – you can stop it doing 
this by holding down the Ctrl key whilst you move the toolbar. 

Viewing the Toolbar 

X To show/hide the toolbar 
1. Click on the View menu, click Toolbar. Depending on its current 

state, the Toolbar will either be switched on or off. 

If the Toolbar is currently enabled, the button next to its name will be 
shown with a ‘tick’. To switch it off or disable it, click on the word 
Toolbar.

Navigation bar 
As well as the main application toolbar, many of the forms within 
Stockit also have a toolbar along their lower edge. This is called the 
“navigation bar”, as its purpose is to help you navigate through the 
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records on the form. It also contains buttons that allow you to addition, 
edit or delete records. 

Status bar 
The status bar appears across the bottom of the main Stockit window.  

The message area at the left-hand end shows prompt information about 
menu or toolbar options. Also shown on the status bar is the company 
name for the database you are using, and your currently active 
production job. 

X To show/hide the status bar 

1. Click on the View menu, click Status Bar.

If the Status bar is currently enabled, the button next to the Status Bar 
name will appear latched. You may switch it off if you require the Status 
Bar to be off. 

Grids 
Many of the windows that you will use within Stockit contain a table or 
’grid’ of information. These allow you to view many records from the 
database in an easy-to-read list. 

Additional features also allow you to search for particular records, sort 
records into order, view selected ‘subsets’ of records, and change which 
fields are displayed. These features are described in more detail in the 
“Tutorial Guide” later on. 

Finding and filtering 
The Finder tool will help you to locate items in the database quickly and 
easily. You will be able to search for items on any of the fields in the 
database, for example the 'Description' field of a stock item, or the 'Job 
number' of a purchase order. More details on how the Finder can be used 
are given in the “Tutorial Guide” later on (see “Finding and filtering” on 
page 53). 

Standard keystrokes 
Shortcut keys provide you with quick and easy access to frequently used 
functions. These keys are predefined using standard keys on your 
keyboard, as listed below. The keys are also shown alongside the 
corresponding menu items. Note that some keys are not always 
appropriate, so they are not available all the time. 
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Key Action Ctrl+Key Shift+Key 

F1 Help  About 

F2 Edit Record  Show Stock 

F3 Find  Show Suppliers 

F4  Close 
Window 

 

F5 Refresh  Show Categories 

F6   Show Parts Lists 

F7   Outstanding 
Orders 

F8 Copy Record  Enter Order Items 

F9 Options  Goods In 

F10  Save & Exit Show Jobs 

F11 Insert Line  Check Stock 

F12  Reports Allocate 

Page Up Prev. Record First Record  

Page Down Next Record Last Record  

Insert Add Record   

Enter Edit Record 
 
Save Current 
and Add 
New Record 

 

Space bar Display 
record 
selector 

 

Right hand mouse menus 
The right hand mouse can be used in some places to access shortcut 
menus. These are also known as context menus or popup menus.
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The example above shows the contents of a typical shortcut menu, this 
one is from the grid in the Stock form. 

Once displayed, the shortcut menu will remain on the screen until an 
option from it is selected or the Esc key is pressed. 

Printing 
Printing from within Stockit uses the standard Windows Print, Print 
Setup and Print Preview options. Stockit therefore supports printing to 
any Windows-supported print device. 

As well as printing reports, you can also print out any grid. Using the 
Print Preview option will show you what the printed page should look 
like before you commit it to paper. 

Online help system 
Stockit provides an online help system in ‘HTML’ form, accessible 
through a browser that is similar to your web browser. This provides 
detailed information about every option within the Stockit product.  

The help window is split into two main sections. The left hand 
navigation window displays the Contents list, the help Index, a word 
Search facility and a Favorites selection for retaining pages 'marked' by 
you. The right hand Help window provides you with the context help 
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pages. These pages are located from one of the options on the left hand 
window or by using the F1 key to obtain context help on each dialog. To 
view any of the topics that appear in the Index or Contents sections, 
double-click the mouse while over the item required. Alternatively, 
select the item and click the Display button. 

When using the Search facility you can search for word strings by 
encapsulating the string in double quotes, e.g. “Stock”. 
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Chapter 4. The Quick Guide 

Introduction 
This chapter is a brief tutorial to get you started with Stockit. It covers 
some of the basics of the product, and will guide you through each 
button press so that its operation is clear at all times. 

Tutorial Database 
For this chapter we have provided you with a tutorial database that you 
can access using a single menu command. 

X To load the tutorial database 

1. Start Stockit. 

2. Click on the File menu, click Database> and Tutorial.

3. The current database will be swapped out for the tutorial database. 
This database is pre-loaded from a dummy company complete with 
stock components, suppliers and parts lists. 

General points 
Before you start to use Stockit there are a few basic points to cover first. 

Stockit can be ‘driven’ in various ways depending on your preference; 
using the keyboard shortcut keys that the program recognises, using the 
mouse and menu options, or using the mouse and the toolbar icons. All 
shortcut keys are listed under “Standard keystrokes” on page 34, 
showing you the keys and their actions. 

Most of the interaction is done using ‘forms’ or ‘dialogs’. Any form or 
dialog (the page or window which opens when you select an option) can 
be instantly closed using the Ctrl+F4 key combination on the keyboard. 
You can also use the Cancel or Close buttons that appear on some 
forms, or the small X button which appears in the top right hand corner. 

Help 
Pressing the F1 key at any time will display the online help which will 
be ‘in context’ for the current operation. In other words, the online help 
will open at the help page corresponding to the form or dialog you are 
using. You can use this to find more detailed information at any time. 
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Once the help is opened, you can use the Contents page or the Index 
page to find other help items. 

You can run help along side Stockit or close it each time when you have 
finished using it. If you click on Stockit while the help is running, help 
will be sent to the back out of the way. It is still running and can be 
selected at any time by clicking F1 or clicking on its icon along the 
Taskbar at the bottom of your screen. 

The Main Window 
The user interface is structured into 3 main areas (other than the database 
windows and dialogs). You have the main menu, from which all 
functions and options can be accessed. There is the toolbar that has 
commonly used tools on it, and there is the status bar that shows prompts 
when an option is selected and information relating to the current 
database or job. 

The menus are structured in such a way that as you move through your 
manufacturing process you also move from left to right across the 
menus. Each of these menu options will be dealt with as they are used. 

Getting Out 
To exit the main application, you can use the Exit option on the File 
menu, or the small X at the top right hand corner of the main Stockit 
window. You will be prompted to save any unsaved changes before the 
program closes. Backups of your data will be dealt with later on in the 
manual. 

An Example Product 
As we have already mentioned, the tutorial database contains examples 
of actual product data to allow the features of the product to be explored, 
and to help you become familiar with the techniques involved. The 
example product itself is a small motor speed controller. We will begin 
by looking at what is involved in making this product. 
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The Structure of the Example Product 
First, we will look at the overall structure of the product. From the 
Reports menu, choose Part Structure. Click on the drop-down list of 
Part Numbers and choose EXAMPLE-PRODUCT 

 

The ‘report’ area below this will now be redrawn, and will show you a 
graphical representation of the product structure: 

You will see from this report that there are five sub-assemblies, one of 
which includes another sub-assembly (a printed circuit board). You may 
also notice that there is another option to the right of the Part Number, 
called “Include Stock Items”. Click on this checkbox so that it is 
‘ticked’, and the report will be redrawn to show you all the stock items 
used within each of the products and assemblies: 
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Reading a Parts List 
Opening a parts list 

Now that we have looked at the overall structure of the main product in 
the tutorial database, we will look at the Parts List for one of the 
assemblies in more detail. 

From the Stores menu, choose Parts Lists (or click the Parts Lists icon 
on the toolbar). The form that opens shows you all the parts lists in the 
database: 

In the right-hand part of the form is a grid showing all of the parts lists, 
with one row per parts list. In the left-hand part is a group of fields or 
‘controls’ that show the values for the parts list that is currently selected 
in the grid. In this case the EXAMPLE-PCB is selected in the grid, so 
the form controls show the values for that parts list. 

Below this, along the bottom of the form, are a number of buttons and 
controls that allow us to navigate through the records in the table, edit 
each record, and find particular records. We will have a closer look at 
how to use these a little further on in the tutorial, but for now we will 
concentrate on finding our way around the different kinds of forms. 

In this case, what we actually wanted to see was the details for the 
contents of the parts list. With the EXAMPLE-PCB record selected, 
click the button Edit PartsList Contents.

A moment later, a new form will open, this time showing the overall 
details of the parts list we chose, and all the items that this parts list 
contains. This is drawn on the screen to look like a form that you might 
fill in on paper. 
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Depending on the resolution of your screen, and the size of the main 
Stockit window frame, you may not be able to see the whole width of 
the parts list form. If you want to see more, move the cursor over the 
right-hand edge of the form until the cursor changes to a left-right arrow, 
then press the left mouse button down and hold it down whilst you move 
the mouse further to the right. This will stretch the form so you can see 
more of the information in it. When the form is as big as you would like, 
release the mouse button. 

You can also use the ‘scroll bars’ along the right and bottom edge of the 
window frame, or use the arrow keys on the keyboard, to move up and 
down through the items on the form. 

What a parts list contains 
The top portion of the parts list form shows the ‘overall’ information for 
the whole parts list, including the description, the date it was first 
created, and when the cost was last calculated. 

In the area below this, each line of the form shows an item from the parts 
list. An item may either be a text item (including a blank line) with text 
in the ‘description’ column, or a reference to a stock item (with a 
description, quantity, and optionally an identifying ‘reference’). 

In this parts list, blank lines are used to group items together to make the 
list more meaningful. The arrangement of items is entirely under your 
control, and there are options to allow you to insert new items at the 
correct position in the list, and to help you arrange items in a different 
order if you need to. 

Printing a parts list 
As well as viewing the parts list on the screen, you can of course print it 
off if you need a paper copy. From the File menu, choose Print 
Preview. The form will change its appearance, now looking exactly like 
it will if you print it out. 
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Buttons have appeared along the top of the form, allowing you to print 
the parts list out, and to ‘zoom in’ to take a closer look at the image. The 
Close button will close the print preview and return the form to its 
‘normal’ appearance. 

If you want to look at a printed copy of the parts list, press Print and the 
standard Windows print dialog will open, allowing you for example to 
choose which printer to print it on. 

Costing the Product 
As we have seen from the example we have just looked at, a parts list is 
generally composed of a number of items, each in varying quantities. If 
you still have the parts list form open, you can see the cost shown in the 
upper area of the form. 

As you create new a parts list, or add items to an existing one, the cost 
for each 'line' is calculated automatically for you, even if you change the 
quantity of the particular stock item on that line. The overall cost of the 
whole parts list, however, is not re-calculated all the time, as this would 
probably be time-consuming enough to get in the way of the usual 
smooth operation. Instead, you choose when to re-calculate this cost. 

On the parts list form (re-open it from the main Parts Lists form if you 
need to), use the mouse to double-click on the cost that is already shown. 
If you prefer using the keyboard, use the arrow keys to move the 
selection 'box' to the cost, and press the space bar. 

A 'message box' pops up, asking you to confirm that you want the cost to 
be re-calculated. Click on Yes, and the total cost of the parts list will 
quickly be re-calculated for you. Now close the parts list form (by 
clicking on the X at the top right corner), and confirm saving the 
changes. 

Costing many products 
As well as re-costing an open parts list, you can also re-calculate the cost 
of many parts lists in one go. From the Financial menu, choose Update 
Costs. This dialog shows you a list of all the parts lists, allowing you to 
select the ones you want to re-cost. 
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Click on Select All and all the entries in the list will be selected. Now 
click on Update Cost, and in a few short moments the cost of all the 
parts lists will be updated to reflect the current stock item costs. When 
this is done, click on Close to close the dialog. 

Multiple Level Structures 
Stockit allows you to create complex structures or ’hierarchies’ of parts 
lists, allowing you to group together stock items and build instructions in 
whatever arrangement you need. No distinction is made between 
products - top-level parts lists that represent end products - and 
assemblies - sub-products that you build (or have built). The ability to 
view and select items meeting particular criteria - which we will come to 
shortly - allow you to differentiate between these requirements  

This flexibility allows you to create parts lists to represent your 
assemblies, and build batches of these assemblies to hold in stock, and 
also to construct complete products by combining all the assemblies that 
go together to make that product. There is no limit to how many levels 
you can use. 

Checking Stock and Quotes for Shortages 
You should now have a good feel for parts lists and how they fit 
together, the way a complex product can be built up from multiple levels 
of parts lists, and how information appropriate to the different stages of 
production can be defined. 
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Now we are going to see how easy it is to use some of the features of the 
production side of the program, planning a production job, checking the 
stock implications of what you plan to build, and how to order 
components from your suppliers. 

From the Production menu, choose Jobs. This will open another form, 
showing you the list of jobs already in the database. As you can see, 
several jobs are already listed: 

As with the parts lists form, the right-hand part of this form shows a list 
of the jobs. The left-hand part shows the controls for viewing and editing 
the overall details of each job, and below this is a group of buttons for 
the various actions you can carry out on a job. These actions are also 
available as options from the Production menu.  

Using the mouse, click on the last job shown in the grid, the one with job 
number KIT020004. Many of the production actions are carried out on 
the specific job selected in the Jobs form. 

You will notice as you click on the job in the grid to select it, that the 
’active job’ indicator at the right-hand end of the main status bar changes 
to show the job number of the one you’ve just selected.  

Some of the action buttons will become available while others will be 
‘greyed out’. This reflects the status of the active job. In this example, 
KIT020004 has only just been created so only Mix of Products and 
Check Stock are available. 
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If you drop down the Production menu now, you will see that this too 
shows the job you have selected.  

The section of the menu below the job number shows those actions that 
are applicable to the active job. The other menu options open up forms 
that are not specific to any one job. Some of the options are currently 
“greyed out” as the active job has not yet been started. 

Checking stock 
As you can see from the Status column in the grid, the jobs currently in 
the Tutorial database are all at the first stage in the production cycle; 
they have been 'created', but nothing else has been done to them. 

 Now we will check the list of components required to build this job 
against the current stock levels. Click on the Check Stock button on the 
Jobs form, or on the toolbar, or choose Check Stock from the 
Production menu. 

The Shortages view now opens, listing all the items that you would need 
to buy if you wanted to build the products in this job. You can see that it 
also shows you an approximate cost of these 'missing' items. 

Of course, the prices you have currently listed against your stock items 
may not be up-to-date. To deal with this, you can request Quotes from 
your suppliers for the items needed to build this job. Press the Quotes 
button on the shortages form, and you will see a report form open up 
showing you a set of quotes, one for each supplier you need to contact, 
with all the appropriate components listed. 
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The quotes have taken into account any existing stock in stores, and 
whether the components are bought singly, in exactly the required 
quantities, or in some pack quantity. 

Stores Picking List 
If you switch back now to the Jobs form (either by clicking in it if you 
can still see it, or by choosing it from the Windows menu), you will see 
that the job status is now shown as Trial Kit.

This shows that you have explored the possibilities of building this job, 
but have not yet committed to actually building it. (The other stages in 
the production cycle will be covered in more detail later). 

Now that you have created a production job and checked its 
requirements against current stock levels, you can open the picking list 
that you would need to get the necessary items out of stores. 

From the Manufacturing menu, choose Picking Lists. The form that 
opens now shows you the picking lists for jobs ready to go into 
production or already in production. 

Note: Picking lists for products that have been completed are available 
through the Reports option. 

Of course, as there are still some items we need to order for our 
production job, we wouldn’t be able to rush off to stores and get all the 
parts just yet! We would need to place the necessary orders on our 
suppliers, and await delivery of the items before proceeding. This is 
described in more detail in the next chapter. 
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Assembly List 
As with picking lists, you can view (and print) the assembly list needed 
for your workshop to actually build the product. From the 
Manufacturing menu, choose Assembly Lists.

Choose one of the assembly lists shown, and click View Assembly List.

Review 
In this chapter we have covered some of the basic operations of Stockit, 
including: 

• How to switch between main and tutorial databases 

• How to access online help 

• Viewing, printing and costing a parts list 

• Looking at a production job 

• Calculating stock implications of taking a job into production 

• Viewing picking and assembly lists 

In the next chapter we will go through the main areas of the product in 
more depth, again in ‘tutorial’ style using the same tutorial database. 
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Chapter 5. The Tutorial Guide 

Guided Learning 
One of the best ways of becoming familiar with a program is to try out 
all the features in a guided learning programme. The Tutorial Guide will 
take you through all the aspects of using Stockit in a structured tutorial. 
The more complex aspects of initially setting up your own database are 
dealt with in the next chapter. 

In the previous Quick Guide section of this manual, we looked very 
quickly at some aspects of using Stockit. In this section we show you 
how to enter the underlying information and carry out Production 
Planning and Stock Control.

When you have worked through this section and discovered how to set 
up your own database, the remaining sections of the manual, and of 
course the Index at the back, should help you find quick answers to 
specific questions. You also have the context sensitive help available 
from within the program at all times, providing you with help on each 
facet of the product (use the F1 key to call up help). 

Company information 
One of the first tasks to carry out is to enter your company information 
into the database. From the Tools menu choose Options, and then click 
on the Company tab.  



52 Stockit Users Guide  

On this page, enter your company name, address and other details. These 
details are used when orders, reports and other paperwork is printed. 
There is only one set of this information in the database. Changing this 
information will affect all paperwork that is printed from then on, 
including reprinting any existing records.

Reg No: 
The Reg No entry is available for your companies’ registration number. 
This box can take any mixture of numbers and letters. 

VAT No: 
The VAT No entry is available for your companies’ local VAT or tax 
registration number. This box can take any mixture of numbers and 
letters. 

Stock components 
Once you have entered your company details (something that you will 
probably only do once), the next task is to set up your stores 
information. From the Stores menu, choose Stock to open the Stock 
form.  

Grids 
In common with many of the screens in Stockit, the Stock form contains 
a table or ‘grid’, listing the items already in the Stock database table in 
our Tutorial database. Click on any of the records you can see in the 
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grid, and the record will become ‘selected’. At the same time, the other 
fields on the form are updated to show all the details from the selected 
record. 

Moving through grid records 
Move the cursor over the grid and click on one of the rows with the left 
mouse button. You’ll see the fields on the form refresh to show all the 
values for the selected record. The grid shows only some of the fields 
but is easier to use for navigating through the whole set of records in the 
table. 

Once you are working in the grid, you can use the arrow keys on the 
keyboard to move back and forth through the records. The up arrow 
moves back towards the beginning of the list, and the down arrow moves 
towards the end. 

If you cannot see all the columns in the grid, the scrollbar at the bottom 
edge of the grid will allow you to scroll across to see the other columns. 

Finding and filtering 
The Finder tool will help you to locate items in the database quickly and 
easily. You will be able to search for items on any of the fields in the 
database, for example the 'Description' field of a stock item, or the 'Job 
number' of a purchase order. 

As we are currently working with the stock form, we can try searching 
for a particular stock component. In the drop-down list on the 
navigation bar of the stock form, choose Part Number. Now click in 
the edit box to the right of this field name drop-down, and press C.

You will see the selected record in the grid change to select the first 
stock item whose part number starts with the letter C. Whatever you type 
in this edit box, the program will try and find the first stock item that 
matches. If there is no item that matches, the first record is selected. 

More specific searches 
As well as finding items with a field that starts with particular text, we 
can perform a more detailed search using the Finder tool itself. Click on 
the button on the stock form’s navigation bar that shows small pair of 
binoculars. This opens the Search dialog. 

The first control on this dialog lets you choose the field to search on, the 
same as the drop-down list on the stock form itself. The second field, the 
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‘Find’ edit box, is where you type in the search text. The bottom drop-
down list allows you to choose how the search should be done, matching 
the start of the field, the whole field or any part of it. 

Choose Any part of field from the Match drop-down list, and Part 
Number from the Field drop-down. Now click in the Find edit box, and 
enter the letter B. You will see the selected record change, to the first 
one with a B in its part number. Now enter the letters L and U, and you 
will see that the selected record is now the first one with the word BLUE 
in the part number. 

Displaying only some of the records 
As well as using the Search tool to help you find the record you might be 
looking for, you can also use the Filter tool to make the grid to only 
display some of the records. This might be useful for example if you 
wanted to scan through all the stock items from a particular supplier, or 
those in a certain category. We will use it to view all those items that we 
build ourselves, that is all those with ‘Factory’ as the supplier. 

Press Close to close the Search dialog now, and click on the next button 
along from the Search button. This opens the Filter dialog, which 
actually looks very similar to the Search dialog: 

As with the Search dialog, two drop-down lists allow you to select the 
field name and how to apply the text you will enter. From the Field 
Name drop-down choose Supplier, and from the Match drop-down 
choose Whole Field.

Now enter the word FACTORY in the Filter edit box. As you start to 
type this in you will see that the records in the stock form grid disappear! 
This is okay, they haven’t really disappeared, it’s just that the grid is 
only displaying those records that match your filter, and there aren’t any 
stock components with a supplier called “F” or “FACT”. As you enter 
the “Y” at the end of “FACTORY”, you will see records re-appear in the 
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grid, but this time instead of seeing all the records in the stock table, you 
only see those with Supplier set to FACTORY. 

Having seen a little of how this feature works, we can dispose of the 
filter and the dialog itself. Click on Clear to clear out the filter we’ve 
been using, and close the dialog. All the stock records will now have re-
appeared in the grid. 

Entering a new stock item 
Now we’ve had a go at finding our way round the stock items we’ve 
already got in the database, it’s time to start making some changes. Click 
on the + button on the navigation bar to start adding a new record. You 
will see all the fields on the dialog ‘light up’, showing you that they are 
now editable. In addition, the field that is currently being entered (in our 
case the Part Number) will be highlighted in the ‘Active Field’ colour. 

First, type in BC182L as the part number, and press Tab to get to the 
next field. As you do this, you’ll see the new part number is copied to 
the Supplier and Manufacturer part numbers for you. 

Next, enter “Low power NPN transistor” as the description, then press 
Tab again. Now we need to choose a category, so drop down the list of 
categories and choose “TRANS NPN”, then press Tab once more. 

The Record Selector 
Now we need to select a suitable supplier. This time, instead of dropping 
down the list to see the supplier names to choose from, we’ll use another 
powerful feature to help us find the right one. Press the space bar on 
your keyboard, and a new dialog will appear. This dialog, most of which 
is taken up with a grid rather like the one on the stock form, is called the 
Record Selector and is used in many places in the program where you 
are asked to choose something from a list. 

In this case, the Record Selector shows us a whole range of information 
about the suppliers we have in our database. Access to this information 
might be necessary if, for example, you have only been told the suppliers 
account number for this new stock item. 

As with the stock form itself, there is a navigation bar along the bottom 
edge of the Record Selector that allows you to search through the 
records shown to easily find the one you want, in the same way as we 
did just now when searching and filtering the stock records. 

Using the arrow keys or the mouse, choose “MILSPEC” as the supplier, 
and confirm this as the one you want to use by pressing Enter or by 
clicking on the ‘tick’ button on the navigation bar. The Record Selector 
will close and the chosen supplier will be selected on the main stock 
form. 
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Completing the stock record 
Manufacturer is an optional field that you can use to specify a 
particular manufacturer for this part. We will leave it blank, as we are 
only creating a stock item for a generic transistor component. 

The Pack Qty field is the quantity in which this item is supplied. For 
example, enter 5 if it is supplied in packs of 5. Just press the Enter key to 
leave this at the default setting of zero, which indicates that this part is 
not bought in pack quantities. 

Unit Cost is the ‘per piece’ cost of the item. Pressing the Enter key with 
a zero cost would open another small dialog that helps you to calculate 
unit cost from pack quantity and pack cost. If the pack quantity was 5 for 
example, you could enter a pack cost of 0.80, and the unit cost of 0.16 
would be calculated for you and ‘plugged in’ to the field on the main 
stock form. For our example though, just enter 0.119 as the unit cost. 

Qty Units is the unit of measurement for the part. You can choose any 
of the units shown in the drop-down list, or enter your own units if the 
one you need is not shown. One of the commonest units is “ea” (for 
‘each’), which is offered as the default. 

Date Costed will already be set to today’s date, but it can be changed if 
you want, either by using the up/down buttons, or by pressing the small 
‘calendar’ button alongside it and choosing or entering the required day, 
month and year from the small popup dialog that appears. 

Current Stock is the amount of this stock item currently held in stock. 
Enter 3 for this value to show we have 3 in stock. 

You will now need to enter information about stock levels. The first item 
is Minimum Level. Use this to show the minimum ‘reserve’ level you 
wish to hold for this stock item, and is used in the Replenish Stock 
option to auto-generate supplier orders needed to refill your shelves. For 
our example, set this to 10 to show that new stock should be ordered if 
the stock level drops below 10. 

Replenish Level is the level to which the Replenish Stock option should 
raise your stock level. If this is zero, only enough will be ordered to raise 
the level up to the Minimum Level. We will set this to 20, so that stock 
will be increased to (at least) 20 when replenishment orders are placed. 

Min Order Qty is used to specify a minimum quantity that must be 
ordered for this part. We can leave this as zero to indicate that there is no 
particular minimum quantity that must be ordered. 

The next three fields are for setting up quantities On Order (the amount 
currently on non-production orders from suppliers), and for production 
the quantities Allocated (the amount of stock that is currently 
‘earmarked’ for production) and On Order (the amount currently on 
order for production). These fields are not yet editable (to show that they 
are not generally to be edited). They can be ‘unlocked’ if necessary by 
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clicking the small padlock button alongside. We can simply Tab past 
these three fields.  

You will now see that the ‘tabs’ in the middle of the stock form have 
switched over, bringing the ‘Notes and Options’ tab to the front so you 
can fill in the next fields. 

Location is the physical location where this part is held in your stores. 
You can use whatever numbering scheme you need when you get as far 
as setting up your ‘own’ stock items, but for now just enter something 
like ‘BAY 116’. 

The Notes field is a free-form field where you can enter any notes or 
comments about this stock item. We will leave it blank for now. 

The next few fields are ‘yes/no’ options. Unrestricted Quantities is 
used to show that the stock item is not dispensed in measured quantities 
that have to be ordered, but rather is available in ‘limitless’ amounts. 
This is used, for example, to define stock entries for build or test time, 
allowing you to factor in the cost of these activities to a parts list 
defining a product you build. 

The switches for Item Has Parts List and Auto Expand are used for 
parts lists, which we will come to shortly, so you can leave these 
unchecked. 

Item is Obsolete indicates that this is a stock item that you no longer 
call up (but you may need to retain it here for use in examining historical 
information). Leave this unchecked too. 

Item Has Shelf Life is exactly what it says, its an indicator to you that 
this stock item needs to be used within a particular time period, or 
perhaps simply on a first-in first-out basis. Once again, leave this 
unchecked. 

Finally, there are three fields called User1, User2 and User3. These are 
provided for you to enter your own information against stock records. 
You can change the name of one of these fields by clicking on its button 
and entering the name you wish to use. 

Note: The field names for User fields apply across the whole stock table, and 
for all users. Changing one of the field names here will affect all users 
and all stock items. 

This completes the creation of our new stock item. If we had more to 
add, we would now press the Enter key to save this item and start adding 
the next, but as we’re only going to add one you can just click on the 
Save button on the navigation bar, or press Ctrl and F10.
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Copying records 
Having seen how easy it is to add a new stock item, we’ll now see how 
we can make it even easier! If we need to create a stock item that is very 
similar to one we have already got, we don’t need to enter all the details 
for the new one from scratch. Instead, we can copy the existing item and 
simply change the bits that are different. 

With our new BC182L transistor record still selected, click on the Copy 
button on the navigation bar. This will add a new record, much like we 
had when we started adding the new transistor just now. However, you’ll 
notice that the settings for all the fields are left just as they were in that 
record, with the part number field selected ready for us to change its 
name. Change BC182L to BC182N, and click the Save button to finish. 

Customising the grid 
Before we leave the stock form, we’ll have a quick look at how we can 
‘customise’ the contents of the grid to suit our own purposes. 

Move the cursor over the top row of headings in the grid, onto the 
dividing line between two of the columns. (the cursor will change to 
show that it may be selected). Press and hold down the left mouse button 
to drag the column divider to the left to reduce the width of the 
Description column. Move the cursor back to the column divider and 
double-click with the left mouse button, and the column to the left of the 
dividing line will auto-size to fit the longest text in that column. These 
features can be used to resize any of the columns in the grid. 

Now, move the cursor over the Description column header, and again 
double-click with the left mouse button. Activating the column in this 
way will sort the records into order on the field you have selected, in this 
case sorting the stock items into ascending order on their description. 
Sorting again will reverse the order, showing the records in descending 
order. 

Note: As with ‘filtering’ records, sorting them doesn’t affect the way the 
records are stored in the database, only how they are presented on your 
screen. 

Now, with the cursor still over the grid, click with the right mouse 
button this time. When the small ‘popup’ menu appears, choose 
Customise. When the Customise dialog opens, you will see two lists. 
The right-hand list shows the fields from the Stock table that are 
currently displayed in the grid. The left-hand list shows the other items 
that you can display if you wish. 



Stockit Users Guide 59 

To change the fields that are displayed, double-click on the field name to 
move the desired field between the two lists, or click once on the field 
name and press the Add or Remove buttons. 

As well as choosing which fields to display, you can also choose the 
order in which they appear, by selecting one of the ‘displayed fields’ and 
using the Move Up and/or Move Down buttons to adjust its position in 
the list. 

Note: Columns may also be re-ordered directly within the grid by first 
selecting a column by clicking in its heading, then dragging it with the 
mouse to its new position. 

Close the Customise dialog by clicking on the Cancel button. 

Entering suppliers and categories 
Adding a new supplier or a new category is just as easy as adding a 
stock item – or simpler, in fact, with much less information to enter. 
Open the Suppliers form by clicking on the Suppliers button on the main 
toolbar, or by choosing Suppliers from the Stores menu. 

When the form opens, you will again see the now-familiar ‘controls plus 
grid’ arrangement, with the details of the first supplier shown on the left 
side of the form, and the table of all the suppliers on the right side. 

Press the Insert key on the keyboard to start adding a new supplier 
record. Enter “ActParts” as the supplier name, and press Tab to get to 
the next field. Type in any values you like for the remainder of the fields 
on the form, and press Ctrl and F10 to finish. The optional ‘Full Name’ 
field should generally be given a value, as this field is the one used to 
print out on things like purchase orders. 

Creating a new Parts List 
Parts lists are where the real power of Stockit starts to come into play. 
As we have already discussed, parts lists allow you to specify the 
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contents and build instructions for your products and assemblies in some 
detail. They are the basis for assembly lists, picking lists, and the whole 
production cycle. 

Starting the parts list 
From the Stores menu choose Parts Lists, or click on the Parts Lists 
button on the main toolbar. Press the Insert key, or click on the Add 
button on the parts lists form’s navigation bar, to start adding a new parts 
list. 

You will first need to enter the part number, so type in “TRIAL1”. Press 
Tab to get to the next field, and enter “Test sub assembly” as the 
description. The revision number we can leave blank; you can use any 
revision numbering scheme you want, but for now we won’t concern 
ourselves with how this might work, so just enter “1” as the revision. 

You will also need to choose a category as we did when adding our new 
stock item earlier. Don’t forget that you can open the Record Selector by 
pressing the space bar in the category field, or by choosing the <Choose 
Category> entry in the drop-down list. 

Now choose a supplier from the drop-down list.  Entering the first one or 
two characters is a quick way of scrolling the drop-down list to the item 
you require. As we’re going to build this assembly ourselves, choose 
“FACTORY” as the supplier. 

Now click the Save button. This will save the new parts list details you 
have entered, and will also create the corresponding stock item for you. 
It will also open the parts list contents form itself, ready for you to start 
adding items to our new parts list. 
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Editing the new parts list 

As we saw in the previous chapter, the parts list form is divided into two 
areas. The top area shows the overall information for the whole parts list, 
including the description, the date it was first created, and when the cost 
was last calculated. In the area below this, each line of the form will 
show an item from the parts list, although of course we haven’t added 
any yet. 

Adding stock components 
Click on the Add Stock Component button on the navigation bar, or 
press the Insert key, to start adding our first item to the new parts list. 

As soon as you do this, the Record Selector pops up, showing you the 
list of stock items. If you start typing “BC182L” (the name of the new 
transistor item we created earlier) you will see that this item is selected 
for you as soon as you start typing. As soon as it has selected the part 
you want, press Enter to accept that item. 

The Record Selector hides away, and the part number of the stock item 
you chose appears on a new line on the parts list form, and the selection 
‘box’ moves to the quantity column. Type in 1 for the quantity and press 
Enter, and the Record Selector appears again ready for you to choose the 
next stock item. 

Choose BC182L three more times, so that we’ve got four of these 
transistors in the parts list. You can leave the Quantity field blank; the 
program will fill this in for you later on, as it assumes that unless you 
specify otherwise, all items should be “quantity 1”. 
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Dismiss the Record Selector by pressing Esc or by clicking on the red 
‘cross’ button on its navigation bar. 

Adding text items 
Now add a couple of blank lines to the parts list by pressing Enter. As 
each one is added, the selection box moves to the description column for 
you to enter text. Leave the first one blank, then type in some text such 
as “This is a comment” for the second one. The ability to add blank lines 
and ‘free’ text into a parts list will help you to arrange the layout in a 
form that is clearest for you. 

As well as ‘whole’ items, Stockit can also deal with fractional quantities. 
We will now see how this works by adding 0.3 metres of wire. Press the 
Insert key to start adding another stock item, and then choose the item 
“32/0.2WHITE”. 

Tip: Don’t forget to make use of the ‘quick find’ by simply typing in the part 
number we are looking for. Press Enter as soon as the right part is 
selected in the Record Selector. 

Enter 0.3 as the quantity, to show that we are going to use an amount of 
0.3 of this wire. The units (in this case metres) come from the stock item 
itself, which is defined to have Qty Units as “m”. 

Not-fitted parts 
As well as calling up stock items to build into the assembly, you can also 
specify parts that are ‘not fitted’. You might want to do this, for 
example, if you have a particular part that is used to test the assembly 
you are building, but is not actually built into it.  

Creating a ‘not fitted’ item is very simple. We haven’t actually got any 
stock items like this in the tutorial database, but we can use any of the 
ones we do have to illustrate this feature. Press the Insert key to start 
adding a stock item, and choose the item “26908PSL”. In the quantity 
field, simply enter zero for the quantity.  

Press Esc to cancel the Record Selector when it re-appears. Now you 
have a ‘not fitted’ part in your parts list! If you want, you could edit the 
description to include the words “not fitted”; descriptions for stock items 
are copied from the corresponding entry in the stock table as the item is 
added to the parts list, but are freely editable once they ‘belong’ to the 
parts list. 

Saving your parts list 
Now press Ctrl and F10 to save your new parts list and close the parts 
list form in one action. Any stock items with quantity fields left blank 
will be set to quantity 1 as the parts list is saved. 
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Finding out where components are used 
Once you start to build up the number and complexity of parts lists, 
clearly it can become quite difficult to remember which parts lists use 
which stock items. Stockit will deal with all of this for you, with several 
different options to enable you to tailor the search. 

From the Reports menu, choose Where Components Used. This will 
open the dialog that controls this feature: 

If its not already set, click on the radio button This Part Number.
Choose “CO14BLACK” from the drop-down list of part numbers, and 
press Find. A report will open, listing all the parts lists in which this 
stock item is used. 

To see how this stock item might affect products or assemblies ‘higher 
up’ the structure, set the Indirectly Used checkbox and press Find 
again. A new report is opened, this time listing not only the parts lists 
where the stock item itself is used, but also the parts lists where those 
parts lists are themselves used. So, CO14BLACK is used in EXAMPLE-
SUB2, which in turn is used in EXAMPLE-PRODUCT. 
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Depending on the size and complexity of your database, searching for 
‘indirect usage’ can be a slow process as it searches through all the parts 
lists and their contents. 

Production planning 
Before we move on to look at the production cycle and how to create 
and manage production jobs, we will first take a look at what the 
program can tell us about what has already been done. 

Production history 
From the Production menu, choose Production History. The form that 
opens shows us information about the production jobs already in the 
database.  

From this list, you can see that each batch is given a reference number 
called the ‘Job Number’. This job number is unique across the whole 
database. 

The production history shows you each of the products in each 
production job, showing the relevant status of each one together with 
dates for creation, releasing to production and completion. 

You can see in the picture above that KIT020001 was created on Jan 2nd 
to make a batch of 8 units. The stock was released to production on Jan 
4th, and the job was completed through production on the same day. 

Similarly, KIT020002 was created to build 5 units, and has also been 
completed through the entire production sequence. 

The third job is still in production, and in fact the stock for some of the 
sub-assemblies (indicated by the ‘S’) has not yet been released to 
production. 

Finally, KIT020004 was started on Feb 6th, but no stock has yet been 
allocated. 

This Production History, together with the overall job information 
shown on the jobs form, will give you a clear picture of the progress and 
status of your production jobs at any time. 
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The production sequence 
The production sequence starts with the ‘job’, which has a ‘mix of 
products’ that specifies how many of each product (parts list) to build. 
Any number of jobs can exist at any stage at any time. The list below 
shows the various stages in the production sequence, and the menu 
options or actions that move you from one stage to the next. 

1. Created: new job created, job number assigned, mix of products can 
be chosen and modified. 
 
[Check Stock] 

2. Trial kit: checked mix of products against stock to determine 
shortages. Mix of products can still be modified and shortages re-
calculated. Individual shortage items may be adjusted. 
 
[Allocate] 

3. Allocated: ex-stock items allocated (reserved), supplier orders 
placed for shortages. 
 
[Release] 

4. In production: stock released from stores to production. Doesn’t 
have to wait for all supplier orders to be delivered. 
 
[Work in Progress] 

5. Completed: production complete, optionally returning 
manufactured items to stock. 

Planning a new batch of products 
The first step in planning a new batch of products (apart from the 
original reason for needing the products in the first place, perhaps for a 
customer order) is to create the job and choose the mix of products to 
build. 

Creating a production job 
We are now going to create a small production job and take it through 
the production sequence to see how this works in more detail. Firstly, we 
need to create a new job. Click on the New Job button on the main 
toolbar. 
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This opens the Jobs form (or brings it to the top, if its already open), and 
starts the new job. The next available job number is automatically 
generated for us and entered onto the form. All we need to do is type in a 
description if we want (something like “Test Job” will do), and click on 
the Save button on the jobs form navigation bar. 

Editing the mix of products 
Once the overall job details are saved in the database, the Mix of 
Products form opens automatically. This form operates in much the 
same way as the Parts List form we saw in “Creating a new Parts List” 
on page 59. 

Press the Insert key to open the Record Selector to choose from the 
available parts lists, select EXAMPLE-SUB4 and press Enter, type in 8 
for the quantity, and then press Esc to cancel the Record Selector as we 
only want to build one kind of item. You should now have a mix of 
products that looks something like this: 

Click on the Save button to save the changes, and then close the mix of 
products form. 

Checking available stock 
Obviously, you cannot make a product unless you have the parts to build 
it, so the next step is to check the stock requirements of this job against 
the available stock. 



Stockit Users Guide 67 

Several of the job functions, including Check Stock, work with one job 
at a time. This is known as the Active Job, and the job number of this 
job is shown on the status bar. When you create a new job this 
automatically becomes the active job, so your status bar should show 
KIT020005 as the Active Job. 

Now you can check the available stock, by clicking Check Stock on the 
jobs form, by clicking on the Check Stock button on the main toolbar, 
or by choosing Check Stock from the Production menu. 

Shortages 
Checking stock for a job will open the Shortages form. When you Check 
Stock for the first time on a job (or after you have changed the mix of 
products later on), it examines the list of items needed to build the job, 
and compares this against the available stock. This check takes into 
account any stock that has already been allocated to other production 
jobs. 

At this point we could, if we wanted, adjust the shortages to order more 
items for stock, use different stock levels to check against, and so on. 
Some of these additional functions will be dealt with later on, but for 
now all we need to consider is the list of shortage items. As you can see 
from the picture, this is a list of those stock items you will need to buy if 
you want to build the job (i.e. the mix of products) you have chosen. 

In the case of our newly created job, you should see that we are short of 
just 16 nuts and bolts. In our stock table, the stock records for these two 
items actually specify a pack quantity of 10, so we will need to order 20 
of each even though we only need 16 for this job. This too is shown on 
the shortages form. 

Reserving stock and placing orders 
Up to this point we haven’t made any permanent changes to stock 
information. We have gone through a process of planning, possibly 
revising the plan in the light of cost and revising the orders in the light of 
availability from suppliers. 

Once you are sure that you want to press on with actually putting the job 
into production, the next step is to ‘reserve’ or ‘earmark’ the ex-stock 
items so they don’t get used by anyone else, and to place orders on your 
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suppliers for the shortage items. To carry out this step, press the 
Allocate button. 

This dialog gives you a chance to change your mind, and to set dates for 
delivery. You should always be absolutely certain that you are working 
on the job you expect, and that you are ready to proceed. 

However, we are sure this is the right job and we can continue with 
allocation of stock and placing of purchase orders, so just click the 
Proceed button. If your jobs form is not open, open it again (from the 
Production menu or the main toolbar), and you’ll see that your new job 
has changed status, and is now “Allocated and Awaiting Orders”. 

We can check which orders we are waiting for, by choosing 
Outstanding Purchase Orders from the Stores menu. Here we can see 
our newly placed orders at the end of the list. 

Goods in 
Following the general flow of the production sequence, we will now 
imagine that some time has passed, and we are now ready to book in the 
orders we are waiting for, so that we can get on with building our 
products. 
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From the Stores menu, choose Goods In, or click on the Goods In 
button on the main toolbar. The Goods In form will open, initially 
showing the first outstanding purchase order and the outstanding items 
from it. Drop down the list of order numbers in the top left of the form, 
and select the first order from the list. 

Tip: Once again, if you are not sure which order you need to choose, simply 
press the space bar to open the Record Selector, and you’ll see all the 
details you’ll need to help you choose the right one (including supplier, 
job number and the date the order was placed). 

The grid is refreshed to show the items outstanding on this order. In the 
Reference field, enter the delivery note number from the supplier’s 
delivery note. This will be useful later on if you need to track an item 
back to a particular delivery, so it is worth taking the time to enter the 
right information now. As we don’t actually have a delivery note, just 
enter something like “DN442”. Similarly, the Date Received defaults to 
today’s date, but can be changed if you need to – perhaps if you are 
booking in something that arrived ‘after hours’ the day before. 

Now we need to tell the program how many items we have actually 
received. Press Receive ALL Items to book in the entire order, at which 
point you should see the value in the ‘Received’ column change from 
zero as we accept the outstanding amounts. 

Next we will book in the other order (for our new job). Drop down the 
list of purchase order numbers, and choose the last order number. When 
you are asked if you want to save ‘goods in information’, press Yes. The 
first order we booked in is now saved in the database and the items on 
the second order (our nuts and bolts) are shown. 

Normally you would expect to process all the items from an order on the 
same delivery, but we are going to see what happens if you only receive 
part of an order (Stockit can cater for both partial (under-) deliveries and 
over-deliveries). 

Select the row for our “M3NUT” items, and press Receive Selected 
Item. A dialog enabling details of the received item to be specified will 
displayed with the outstanding quantity already set as the quantity to be 
received. Press OK on the ‘details’ dialog, as we don’t need to change 
the amount received to be any different to what we are expecting. 

Finally, commit the changes to the database by pressing Save Changes.
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Note: Most of the forms in Stockit work directly on the underlying database 
tables, changing information one record at a time as you make your 
changes. Some, however, need to collect a set of information before it 
can be committed to the database, which is what the goods in form 
does.This allows a goods-in session to be cancelled without committing 
to the items specified as received simply by closing the goods-in form 
without saving . 

Releasing stock to production 
We are now ready to try moving our job along to the next stage in the 
production sequence. You can close the forms you’ve currently got open 
if you wish, or just leave them open. 

Although some goods are outstanding (the “M3BY16” screws), we will 
attempt to release the product to production anyway. From the 
Production menu, choose Release to Production.

Select the record for our EXAMPLE-SUB4 in KIT020005, and press 
Release. A small report dialog opens up, showing you that our job still 
has some purchase order items outstanding. The report can be resized if 
you cannot see all the information. 

If we wanted, we could release the product anyway, allowing production 
to start without being delayed by the lack of these items. The stock 
levels may go negative until the delivery comes in, but the figures will 
all balance again once the items are booked through goods in. 

However, we’ll keep things simple for now, so press Cancel, go back to 
the Goods In form and accept delivery of the final outstanding item, 
then come back to the Release Stock form and release our product once 
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again. The message in the report dialog will then tell us that our product 
is now ready for release to production, so press the Release button. 

Work in progress 
From the Production menu, choose Work In Progress. The form that 
opens now shows you the status of all products that have been released 
to production but are not yet complete.  

As you can see, there are several batches of products listed as being 
‘work in progress’. The last one is the batch we have been working on. 

Let us assume that our batch of products has now been built (and of 
course tested!); select the record in the grid and press Complete. The 
dialog that now appears allows you to confirm that this is the batch you 
want to complete. 

Date Completed is set to today’s date by default but you can change 
this if you wish. You also have the option of adding the completed 
products to stock, which we will do by leaving this checkbox set and 
pressing OK.

The ‘confirm’ dialog closes, and our batch of products disappears from 
the list of work in progress. We have now successfully taken a job right 
through the production cycle. 

Look at the stock form to see that the Current Stock quantity has 
increased by the amount we’ve just completed. 

Review 
In this chapter we looked at the following: 

• Setting up your company information 
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• The basics of entering stock records 

• Creating a parts list 

• Finding out where components are used 

• An overview of the production sequence 

• Creating a production job 

• Taking that job through the production sequence 

This is the end of the tutorial section of the manual. The following 
chapters provide more in-depth information on using each area or feature 
of Stockit. 
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Chapter 6. Setting Up Your Own Database 

Introduction 
Having worked through the “Quick Guide” and the “Tutorial Guide” in 
chapters 4 and 5, you should now have a good idea of the way that 
Stockit works.  

Stockit is a very flexible program, so it is usually possible to carry out a 
particular operation or sequence of operations in many different ways. 
The next section of the manual (up to chapter 12) will help you 
understand more about each area of the product. 

Database Structure 
Stockit uses a Microsoft Access database, driven by the Microsoft Jet 
database engine. All the necessary components of the database engine 
are installed onto your system by Setup when you install Stockit, you 
don't need an actual copy of the Microsoft Access application to run 
Stockit. 

Overview 
As with other databases, the data within the Stockit database is held in 
'tables', each table having a number of records in the same format or 
layout. For example, there is a 'stock' table holding stock component 
records, a 'suppliers' table holding your supplier information, and so on. 
These tables may be mentioned in various places throughout the 
documentation. 

Each piece of information within a table record is called a 'field'. Each 
field has properties such as type, size, and whether or not a value is 
required. 

Relationships 
There are relationships defined within the database that specify the links 
between fields in different tables. For example, a stock record has a 
supplier field, which references the supplier name field in the supplier 
table. This relationship means that a stock record must contain the name 
of a supplier that exists in the supplier table. 

In this way, the integrity of your data is maintained for you - you cannot 
accidentally delete a supplier record that needs to be used by a stock 
item. Similarly, if you change the part number of a stock item, all 
references to that stock item change their part number too, ensuring 
continued consistency of your information. 
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Diagram 
The diagram below gives a very simplified overview of the main tables 
in the database, some of the fields in those tables, and some of the 
relationships between the fields. The full database definition (or 
’schema’) is of course more complex than can be shown here, but this 
diagram should give you some idea of how the system fits together. 

 

Sequence to follow entering your data 
We recommend a ‘bottom up’ approach to building your database, 
starting at the lower levels and moving up only when all the necessary 
lower-level data is in place. 

Although Stockit can also cater for a more ‘piecemeal’ approach of 
adding lower-level records only when the higher-level ones need them, 
adopting the sequence shown below will avoid you doing too much 
‘hopping around’. 

Note: Before you start, don’t forget to switch back to the ‘main’ database if 
you are still using the tutorial. 

1. Enter data about all the suppliers that you intend to use. 

2. Enter all the categories of components: these are used to group 
similar components for ease of reference. 

3. Enter your stock components: this is the ‘master list’ of every single 
type of component used in your manufacturing process or held in 
your stores. 
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4. Enter the parts list for each assembly. 

5. Enter the parts list for each top-level product. 

Finally, don’t forget that you can press F1 at any time to get online help 
about the current option or feature. 

The record selector 
The Record Selector is available in many places throughout Stockit, as 
an aid to choosing items from other tables while adding or editing 
information. 

The most common place that the record selector is available is from any 
drop-down list that includes an entry like <Choose Supplier>. The 
record selector can be opened by selecting this entry from the drop-down 
list, or by pressing the space bar on the keyboard. The example below 
shows this entry for the category field on a stock item. 

When you choose this item, the record selector form opens. As with the 
other forms in Stockit, this form is resizable (by dragging the edge or the 
corner of the window with the cursor), but because it is there to help you 
select the right record for a specific purpose you cannot switch away 
from the record selector to another form. Instead it behaves like a popup 
‘dialog’ window, so you will stay ‘locked’ onto the record selector form 
until you choose an item or cancel. 

The same controls for finding and filtering records are available here as 
on other forms, on the navigation bar at the foot of the record selector 
form. To choose an item, select the item on the grid and either press 
Enter on the keyboard or click on the ‘tick’ button on the navigation 
bar. 
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The grid on the record selector can be customised as with other forms, 
by right clicking on the grid with the mouse and choosing Customise 
Grid.

Suppliers 
Where suppliers are used 

Suppliers are used by stock items, to specify the supplier for each one. 
They are also used by stock ‘alternates’, which are used to specify 
alternate sources for a stock item. 

Key fields 
Field Required Unique 

Supplier Y Y 

(Others) N N 

Adding suppliers 
From the Stores menu, choose Suppliers. To start with, the suppliers 
table will have only two entries. The first is called “-“, which is there for 
you to use for any component that doesn’t have a supplier assigned. The 
second is “FACTORY”, that you would use to indicate that you supply 
or manufacture the component yourself. 

Most of the fields on the form are self-explanatory. The ‘Supplier’ is the 
name by which you will reference this supplier from other records in the 
database (such as stock items). The ‘Full Name’ is the company name of 
the supplier, that will appear (along with their address) on documents 
such as purchase orders. 

New suppliers are added by pressing Insert on the keyboard, or the Add 
button on the form’s navigation bar. 
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Fill in the details for the first supplier you are adding, and then press 
Enter to save the details and start adding the next one. Repeat this 
process until you have added all your suppliers, then press Esc to stop 
adding any more. 

If you have several very similar supplier records to add (perhaps you buy 
from the same supplier in different locations), you can press the Copy 
button on the navigation bar to start a new record by copying all the 
values (apart from the supplier name) from the record currently selected 
in the grid. 

Deleting suppliers 
If you want to remove a supplier, simply find the supplier you wish to 
delete, and click on the Delete button on the navigation bar (or press the 
Delete key on the keyboard). 

Before the supplier is removed, the database is checked for any 
references to that supplier, and if any exist (for example if there are 
stock items using this supplier) you will be informed that this supplier 
cannot be removed. The integrity of your database is thus maintained, 
helping you avoid errors. 

Supplier usage information 
Later on, once you have added stock items and started placing purchase 
orders, you may find the two buttons at the foot of the suppliers form 
useful.  

Products supplied 

Clicking on the Products button will open the stock form, primed to 
show only those stock items you buy from the supplier currently selected 
on the supplier form. 

Supplier purchase history 

Clicking on the History button will open a supplier history form, 
showing you a range of information about the items purchased from the 
supplier currently selected on the supplier form. This includes value of 
items purchased, order and delivery dates, and a total purchase value. 
You can even use the Filter dialog to view selected purchase records, 
perhaps to show the amount purchased from them in the last month. 
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Stock categories 
Where categories are used 

Categories are used in stock records, and are simply there to help you 
group similar stock items together. Stockit places no particular meaning 
on any category name. 

For example, you may want to assign a category “PRODUCT” to all 
your top-level parts lists, “ASSEMBLY” to your sub-assemblies, and so 
on. You could then use the Filter dialog when viewing stock items to 
selectively view items having a particular category. 

Key fields 
Field Required Unique 

Category Y Y 

(Others) N N 

Adding categories 
New stock categories are added in the same way as suppliers. From the 
Stores menu, choose Categories, or click on the Categories button on 
the main toolbar. As with suppliers, a form appears that allows you to 
add new records, amend any existing records, and delete unwanted 
categories. 

As with suppliers, checks are made before Stockit will let you delete a 
category. A category that is in use by a stock item cannot be deleted. 

Stock components 
At this step, you can enter all the components used within your 
organisation. Alternatively, if you want to introduce the system 
gradually, you could add only those stock items needed for the first parts 
list you are going to enter, and build up your stock table that way. 

Where stock items are used 
Stock items are used by a variety of other database records, including 
parts lists, purchase orders and production jobs. The stock table is like 
the ‘hub’ of your Stockit database, and it is here that you would probably 
spend most of the time needed to prepare your Stockit database for use. 

Key fields 
Field Required Unique 

Part Number Y Y 

Supplier Part Y N 
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Supplier Y N 

Category Y N 

(Others) N N 

Part numbers 
Each stock item can have three “part numbers”. The first, the ‘Part 
Number’ itself, is your internal or company part number uniquely 
identifying the stock item. This is the value used to reference the stock 
record from other records in the database, and should be the one you 
would naturally expect to use to find parts in the database. 

The ‘Supplier Part’ is the part number (or order code) that your supplier 
would use for this stock item. This may be the same as your part 
number, but it needs to be the order code that your supplier would 
understand, as it is the code that is printed out on purchase orders. This 
field is not constrained to be unique, in case different suppliers happen 
to use the same order number,  but it should be unique within the context 
of an individual supplier, otherwise it may lead to ambiguity when 
ordering from that supplier. 

The ‘Manuf. Part’ is an optional field that you can use to hold the 
original manufacturers part number if you wish. This will appear on 
purchase orders if you choose to use them in their ‘landscape’ format. 

When you create a new stock component, the part number you enter will 
initially be automatically copied to the supplier and manufacturer part 
numbers. You may then change these if you wish. 

Quantities and units 
A stock record contains a number of quantity and unit fields that specify 
how the item is measured, purchased and used. 

The ‘Pack Qty’ allows you to specify items that are purchased in pre-
packaged quantities. This quantity, combined with the ‘Unit Cost’, will 
yield the ‘Pack Cost’, which is calculated whenever Stockit needs it. 

Leave the Pack Qty as the default value of zero if the stock item is not 
purchased in packs. If you enter a Pack Qty, then leave the Unit Cost as 
zero (or click the Calculator button alongside the Unit Cost field), a 
small dialog appears where you can enter the Pack Cost and have Stockit 
calculate the Unit Cost for you. 
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The ‘Qty Units’ can also be specified, which is the units in which the 
stock item is measured. Many will use ‘ea’ (meaning ‘each’), but other 
units are also available (and you can enter your own units if you need 
to). 

Using these fields in combination allows you to specify a variety of 
packaging and usage types. For example, bolts may be supplied in boxes 
of 250 at a cost of £11.75 per box. From this information, Stockit can 
calculate that each bolt costs £0.047. These bolts will be purchased in 
boxes of 250 but used singly. 

In the same way a product may use 20ml of cleaning fluid that is 
purchased in 40 litre drums, or cable can be purchased in 100m reels and 
used by the centimetre. 

Stock levels 
Several stock levels are available in a stock record, some of which are 
optional. 

‘Current Stock’ is the existing stock level, so if you are entering a new 
stock item for existing stock you already hold, you can enter the current 
quantity here. 

Where component supply is known to be unpredictable, or there are 
significant lead times on supply, ‘Minimum Level’ allows you to specify 
a quantity of stock that you wish to maintain ‘in hand’. The Replenish 
Stock option on the Stores menu can be used at any time to check the 
stock levels against these minima and automatically generate the 
‘shopping list’ of items needed to re-stock. If you don’t need a minimum 
level for a particular stock item, leave this field as zero. 

‘Replenish Level’ is used in conjunction with ‘Minimum Level’. When 
generating stock replenishment orders, the Replenish Stock option will 
order enough to raise the stock to the given Replenish Level. For 
example, you could specify a Minimum Level of 10, and a Replenish 
Level of 40. If the stock level then fell to 5, carrying out a stock 
replenishment would order 35 items to give you the necessary “buffer” 
stock. If you don’t specify a Replenish Level, then only enough will be 
ordered to take the stock just above the Minimum Level. This might be 
the right thing to do, perhaps you only use this part infrequently, or it’s 
too expensive to hold large amounts. 
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‘Min Order Qty’ is used to specify the minimum amount of this item you 
need to order when placing an order with your supplier. This may be  
because the supplier insists on a minimum order quantity, or might be 
used for example if you want to take advantage of a price break on bulk 
ordering. The item may be sold in packs of 10, but buying 100 at a time 
may be cheaper per item, so you could specify a minimum order 
quantity of 100 to make sure you get the best price. 

The final three quantities on the stock form (‘On Order’, and the two 
production quantities ‘Allocated’ and ‘On Order’) would not normally 
be adjusted ‘by hand’. These quantities show you the amounts on order 
from suppliers or allocated (ear-marked, or reserved) for production, and 
are modified by Stockit itself when placing purchase orders, booking 
goods in, or processing production jobs. 

Allocated stock is usually physically still in stores, but is held for a 
specific production run, preventing it being further allocated. For stock 
items that are available in ‘unrestricted quantities’ (see “Items available 
in unrestricted quantities” below), the Allocated amount shows the 
amount of that item expected to be used for all ‘pending’ production 
jobs. 

Notes and options 
The ‘Location’ field allows you to specify the physical location of this 
stock item in stores. You can specify this in any way that you like. The 
most important usage for the location of stock items is on picking lists, 
to help your stores staff pick the necessary parts for production or 
despatch. Stockit also provides a ‘Bin Labels’ report allowing you to 
print off labels showing stores location for stock items that can be 
attached to the actual storage bins. 

Each stock item can also have up to 255 characters of ‘free form’ notes 
added, for whatever additional information you need to hold. 

There is also a group of optional settings or ‘flags’ that can be set for a 
stock item. ‘Unrestricted Quantities’ is described below under “Items 
available in unrestricted quantities”. 

Stockit will set the ‘Item Has Parts List’ option automatically when a 
parts list is created for the stock item. If the stock item does have a parts 
list, you can set the ‘Auto-Expand’ option to indicate that this item is a 
sub-assembly that you will always want to build, and will thus be 
automatically “expanded” when calculating shortages (see “” on page ). 

The issue of parts lists and how they relate to products, assemblies and 
sub-assemblies is dealt with separately (see “Products and assemblies” 
on page 99). 

The final two options allow you to specify that the particular stock item 
is obsolete, and whether it has a limited shelf life. Attempting to add an 
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obsolete item to a parts list will warn you that you are trying to use a 
stock item that has been discontinued. 

Custom fields 
Three ‘custom’ fields are provided, for you to add additional items of 
information to your stock records. These fields are initially called User1, 
User2 and User3, but you can set the name of the field by clicking on the 
button with the field name on it and entering the new name. 

It is important to note that the name you use for these fields will apply to 
all stock records; you cannot have one record with its custom fields 
called A, B and C and another record with them called Time, Price and 
Open. Changing the name for one record changes it for all, so you 
should think about what you are going to use these fields for before you 
start entering data into them. 

Note: Due to the way that some of the mapping is done between the database 
tables and the user interface, the field name for these fields may in some 
cases appear as “Custom_User1” etc. 

As with any other fields, you can add them to the columns displayed in 
the grid on the stock form, using the Customise Grid option that is 
accessed by clicking in the grid with the right mouse button. 

 

Items available in unrestricted quantities 
Setting the ‘Unrestricted Quantities’ option for a stock item allows you 
to specify that this item can be used in production without requiring 
stock to be held or purchase orders to be placed. 

The most common use for this is to add stock items for ‘times’, with the 
units set to minutes. By adding a quantity of such a stock item to your 
parts list, you can factor in how much it costs you in build time, test 
time, and so on. 

At any given time, the ‘Allocated’ field for such items will reflect the 
amount of the item that is currently commited to production. 

You could also use this setting for any stock items that you want to keep 
outside of the Stockit’s inventory control. You might perhaps have a 
component that you acquire in bulk from another part of your 
organisation, so you wouldn’t need Stockit to raise purchase orders to 
buy it. 

Note: It is important to realise that stock items with ‘Unrestricted Quantities’ 
set will not appear in shortages, and stock levels of these item will not be 
maintained by Stockit. 
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Alternative suppliers 
Where alternative suppliers are used 

Alternative suppliers are used by stock items, to specify a list of 
alternative suppliers for a particular stock item. One of these (the one 
shown at the top of the list in the stock alternates form) is the preferred 
supplier, which is the one shown as the actual supplier on the stock 
form. 

Key fields 
Field Required Unique 

Part Number (cannot edit this field) Y N 

Supplier Y N 

Supplier Part Y N 

(Others) N N 

Adding alternate suppliers 
From the Stores menu, choose Stock, and then select the stock item for 
which you need to specify alternate suppliers. Now, click on the 
Alternative Suppliers button to open the stock alternates form for this 
part number. 

Press the Add (+) button on the alternate form’s navigation bar. The Part 
Number field will not be editable, as you are specifying alternate 
suppliers for one specific part. 

Choose the supplier from the drop-down list, or use the record selector 
to help you find the right one.  

Enter the supplier part number, and the manufacturer name and part 
number if you wish. 

Finally, enter the units and unit cost to use when purchasing the stock 
item from this supplier, and press Save on the navigation bar (or Enter 
on the keyboard to save this alternate and start adding another). 

Changing the preferred supplier 
The information for the preferred supplier is shown in the first row of 
the grid. To make a different record the preferred supplier, select that 
record in the grid and press the Set Preferred button. You can also re-
order the rows in the grid by dragging the left-most cell of the selected 
row to the desired position. Dragging it to the top of the grid will make it 
the preferred supplier. 
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As you change the preferred supplier, the information for the 
corresponding stock item on the stock form will update to show the new 
supplier, manufacturer and cost details. 

Note: The information for the preferred supplier is taken from the stock form, 
and cannot be edited on the alternates form. 
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Chapter 7. Purchasing 

Reference numbers 
Purchase orders are all numbered, using a numbering scheme that you 
can control. Each number has an optional prefix, a number that is 
automatically incremented for each new purchase order, and an optional 
suffix. 

Once a purchase order has been created, the order number assigned to 
that purchase order doesn’t change. You can cancel a placed purchase 
order, but you cannot make it disappear from the database. This ensures 
that a record of all activity is maintained, and avoids gaps in the 
numbers. 

How orders are numbered 
Purchase orders are referenced within Stockit using the purchase order 
number described above. Each purchase order may also have a 
supplier’s reference number. You may be given this number, for 
example, when you actually place the order with the supplier. This 
number may be the one that appears on delivery notes, so you will need 
to add it to the purchase order as soon as you know what the number is. 

Ordering stock items 
Orders for production jobs are raised automatically as part of the 
production process, as you will have seen if you have been following the 
tutorial in Chapter 5. 

The procedure for raising non-production orders for stock is really very 
simple. The first stage is to build up a “shopping list” of items you want 
to buy, and the second – that is done for you at the press of a button – is 
to collate all these order items into the necessary number of purchase 
orders to place with your suppliers. 

Along the way you can request quotes to get up-to-date prices, adjust 
order quantities, add and remove items from your shopping list, until 
you are ready to commit to placing the orders. 

The orders you create in this way are ‘non-production orders’, as they 
are not tied to any production job. Orders may also be placed for out-of-
stock items required for production - see “Allocating stock and placing 
orders” on page 111 for details on placing production orders. 
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Entering purchase order items 
From the Stores menu, choose Enter Purchase Order Items. The form 
that opens shows the list of items that are already in the ‘shopping list’ 
ready to be ordered (if any). You will then be able to add the items you 
need to purchase. 

Adding parts to the shopping list 

To add a new item to the ‘shopping list’, click on the Add (+) button on 
the form’s navigation bar, or press the Insert key. Next, you will need to 
choose the part number of the item you wish to purchase. 

You can either choose the part number from the drop-down list (by 
dropping the list and picking it), or from the Record Selector (by 
pressing the space bar or selecting the <Choose Part Number> entry 
from the drop-down list). 

The record selector may be useful for example if you know the 
description of the part you need to buy, but not its part number. The 
record selector grid can be customised to show the stock table fields you 
need to see, in the order you want to use: 



Stockit Users Guide 87 

Choose the required part from the grid, and press Enter or click on the 
‘tick’ button. The record selector will close and the selected part number 
will be selected for you from the drop-down list. 

Ordered, pack and minimum quantities 

Now enter the quantity you wish to buy. If the stock record specifies a 
pack quantity and you haven’t specified a multiple of the pack size, you 
will be reminded and given the option to round up the quantity to order 
to order the next complete pack. If you have specified a minimum order 
quantity in the stock record, this too will be taken into account. 

In the example below, our stock item for yellow wire has a pack quantity 
of 10, and a minimum order quantity of 15. When we attempted to order 
5, this has been rounded up to the next complete pack that is at or above 
the minimum order quantity. In this case we are prompted to order 20 (2 
complete packs). 

You still have the option of over-riding this if you need to, although of 
course your supplier may not be able to send exactly the quantity you 
asked for! 

Scheduling deliveries 
Each order item can have a ‘Required Date’ specified. This makes the 
resulting order into a “scheduled order”, with the necessary date 
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appearing on the order form, so that your supplier knows when to deliver 
the goods. 

As you change the Required Date for order items on the Enter Order 
Items form, the necessary adjustments will be made to the purchase 
orders, including merging two orders if they now have the same supplier 
and date, or splitting into two orders if items on the order are now 
needed on different dates. 

You can also change dates on a complete order form by clicking View 
Order Form and changing the date there (see “Editing the order forms” 
below). This will change the date for all order items on that order. It will 
not, however, merge this order with another if you happen to change the 
whole order date to the same as another order. 

Another field available on the order form itself is ‘Expected Date’. You 
can use this to put in the date when your supplier has said they expect to 
deliver the goods to you. This optional field is only for your information. 

As a stock item may only appear once in the ‘shopping list’ at any given 
time, if you wish to order a quantity of a particular item but split the 
delivery over a series of dates you must use the Item Notes facility 
described below to specify the items’ delivery requirements. 

Completing the shopping list 
Continue adding to the shopping list until you have specified all the 
items you wish to buy. As you add or adjust each order item, Stockit 
automatically assigns it to the correct purchase order against the correct 
supplier. 

Before you actually place the orders, you can preview the resulting order 
form on which a particular order item appears, by pressing View Order 
Form. This will open the order form, complete with supplier details and 
all the items you are about to order from that supplier. 

You can also request quotes from your suppliers, by pressing Quotes 
and printing off the quote forms that are produced. When your supplier 
responds to your request for a quote, you can make the necessary 
adjustments, perhaps changing order quantities or removing items they 
can no longer supply. 

Editing the order forms 
Certain fields on an order form can be edited, by choosing an item on the 
order from the list on the Enter Order Items form and pressing View 
Order Form. The order form appears almost as it will when printed, 
with a row of buttons along the top to allow you to modify fields on the 
order. 
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To modify one of the editable fields, click on the appropriate button and 
then enter the required information. 

Changing one of the date fields will display a popup ‘date bar’ to help 
you choose the right date. 

Clicking on Item Notes will ‘open up’ a notes field below every item on 
the order; enter notes against those items that need them by clicking in 
the relevant notes box, then when you click on a different part of the 
order form the empty notes boxes will disappear. 

Tip: You may not know all the information before you place the order 
(Supplier Ref, for example), but you will still be able to access the order 
form from the Outstanding Orders form or the Purchase Order History 
to change this value even after the orders have been placed. 

Placing the orders 
The final stage in preparing your non-production purchase orders is to 
actually commit to ordering the items you have chosen. 

Click on Place All These Items As Orders. A small dialog appears, 
showing you what is about to happen, and giving you the chance to 
cancel. 
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There is also an option at the foot of this dialog that indicates whether or 
not you want the order forms to be opened for viewing once they have 
been placed. If you have already done everything you want to do with 
the orders, including printing them off, you may want to clear this 
checkbox. 

If you are now sure that you are ready to place your orders, click 
Proceed. The status of the purchase orders will now be moved from 
‘Unprocessed’ to ‘Placed’. Once at this stage, you can only back out by 
cancelling orders or order items, you cannot remove the actual orders 
from the system completely once you have placed them. 

Note: Existing/old purchase orders may be displayed and printed at any time 
individually from the Outstanding Orders form or the Purchase Order 
History or as a group via the Reports option . 

Replenishing stock levels 
Preparing your stock records with the necessary information, and using 
the option to ‘Replenish Stock’ can automate the process of placing non-
production orders for stock. 

Fields needed in a stock record 
To use the automated stock replenishment feature, you will need to 
prepare your stock records with the necessary quantity information to 
allow the appropriate checks to be made and the right quantities to be 
ordered. The Replenishment feature uses two fields in a stock record: 

• Minimum Level: this is the level used to ‘trigger’ the need to 
replenish stock of this item. If the current stock level is below the 
minimum level, more stock needs to be ordered. Stock records with 
this value set to zero will be ignored for replenishment purposes. 

• Replenish Level: this is the level to which the stock must be raised 
when placing orders during the replenishment process. If this value 
is set to zero, the Minimum Level is used instead. 

Note:  Pack Qty and Min Order Qty will also be taken into account if these 
differ from the Replenish Level 

How the required quantity is calculated 
When scanning the stock table for stock items that need ordering, any 
item with a non-zero Minimum Level is checked. 

The projected stock is calculated as: 

[current stock] – [stock allocated to production] + [stock on order] 
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This takes into account stock that is already earmarked for production 
(and is therefore not truly ‘available’), and any quantity already on non-
production orders. This gives a figure for what the stock level will be 
once outstanding orders are received and current production is under 
way. 

If this projected figure is less than the specified Minimum Level, then 
additional stock needs to be ordered. The required level is calculated as: 

 [required minimum] – [projected stock] 

The ‘required minimum’ amount is either the Replenish Level, or the 
Minimum Level if no Replenish Level is specified. 

Finally, any rounding-up necessary to fit with pack quantities and 
minimum order quantities is done, to give a final required amount. 

Using stock replenishment 
To use the replenishment feature, choose Replenish Stock from the 
Stores menu. If this is the first time you have run this option, you will be 
shown a short description of what this option is about to do. 

Set the checkbox if you don’t want to see this message again, and press 
OK.

The stock table is scanned, checking current, projected and minimum 
stock levels. All the necessary purchase order items that are needed to 
replenish stock are added to the ‘shopping list’, and the Enter Purchase 
Order Items form is displayed. You are then able to modify these items 
as described above under “Entering purchase order items”. 

If no orders need to be placed to replenish stock, a message appears to 
tell you this. If your shopping list already had items on it that you were 
preparing to order, it might otherwise be quite difficult to know whether 
stock replenishment had found anything that needed ordering. 
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Note: Stock replenishment can also be included as part of the production 
ordering process. See “How shortage amounts are calculated” on 
page108  for details. 

Booking in deliveries 
Deliveries are booked in using one of the two "Goods In" options, both 
of which are available on the Stores menu: 

• Goods In is used to book in deliveries you are receiving as a result 
of purchase orders you have placed.  

• Goods In (Non Order) is used to book in items received from 
other sources. This might include transfers of stock from other 
sites, or additional stock found during a stock check. 

Order-based Goods In 
From the Stores menu, choose Goods In, or click on the Goods In 
button on the main window toolbar.  

As this form is intended for receipt of deliveries of ordered items, the 
form is arranged to work with one purchase order at a time. The relevant 
purchase order should be selected from the Order Number drop-down 
list. If you only have limited information available, perhaps because the 
delivery note doesn’t specify your order number, press the space bar to 
open the record selector. This will show you more details about each 
purchase order, to allow you to select the right one. 

Note: This option can also be accessed through the Outstanding Order Items 
form, in which case the correct order will be pre-selected for you. 



Stockit Users Guide 93 

Delivery reference 
Every delivery that is booked in must have a delivery reference. This is 
used to track items in production back to the purchase order and delivery 
on which they were received.  

The delivery reference should be entered in the ’Reference’ field. 
Existing delivery references are presented in a drop-down list from 
which you can select a suitable value if you’ve used this reference 
already. The list also contains the value "None" if you have no reference 
to put in. 

Note: If you have set all the ’received’ amounts, but the ’save’ buttons are not 
enabled, the most likely reason is that you have not entered a delivery 
reference. 

Amounts received 

To receive a complete order in one go, press the Receive ALL Items 
button. This will set the ’Received’ amount for all outstanding items to 
the quantity outstanding, effectively preparing the list to complete the 
order. 

To receive individual order items, select the item in the grid and press 
the Receive Selected Item button, or double-click on the item in the grid 
with the left mouse button. This will open a dialog that allows you to 
enter details of the item you are receiving. 

This dialog will default to receiving the currently outstanding amount. 
You can adjust this amount as necessary if you haven’t actually received 
that amount. 
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If only some of the items on the order are outstanding, you can switch 
the records shown on the grid between all the order items and only those 
still outstanding by clicking on the Show Outstanding Items Only 
button. (The text on this button changes to Show All Order Items when 
you click on it). 

Partial and over-deliveries 
If you are only receiving part of an order, or the quantities are not 
exactly as per the original order, there are several ways of doing this. If 
most of the delivery is correct you could receive all the items, then 
adjust the quantities received for those few items that are missing or 
incorrect. 

Alternatively, if you are booking in just a few items, receive each one 
individually and enter the amount of each item being received. 

When receiving over-deliveries on production orders, the amount 
required for the production job will be used to satisfy the allocated 
quantity, and the remainder will simply go into stock. 

Entering goods in costs 
As well as entering quantities, you can also enter a new unit cost of the 
item (if it is shown on the delivery paperwork). This cost can be used 
later to update the costs in your stock records to reflect recent purchase 
prices (see "Updating stock prices" on page 117). 

Alongside the cost field is a Calculator button that opens the small 
calculator dialog allowing you to enter pack cost and pack quantity and 
have Stockit calculate the new unit cost for you. 

Saving the changes 
The Goods In form works by collecting all the information about the 
delivery you are receiving, then committing it to the database only when 
you are finished with that delivery. 

When you have finished booking in a delivery for one purchase order, 
you can save the information by pressing the Save Changes button or 
the Save button on the form’s navigation bar. 
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Alternatively, if you have more deliveries to book in, choosing a 
different purchase order from the order number drop-down list will 
prompt you to confirm saving changes for the current one. 

Non order-based Goods In 
From the Stores menu, choose Goods In (Non Order).

As this form is intended for receipt of deliveries of ’random’ items, the 
form is arranged to work on a part number basis. Choose the part 
number of the item you are booking in, using the record selector if 
necessary to help you identify the correct item. 

As with order-based goods in, all deliveries will need a reference. Unless 
you specify one (even if its just "None"), the Save buttons will not be 
enabled. 

Also in line with the order-based goods in, you can enter a unit cost that 
can be used later to update stock prices. 

Once you are certain the the items details entered are correct, press the 
Save button to commit the Goods-In to the database. The Save button 
will once again become ‘greyed out’ to show that the Goods-In action 
has been done. The dialog will remain displayed to allow another item to 
be booked in. 

Booking items out from stock 
The Goods Out option on the Stores menu allows you to book stock 
items out from stores for whatever need arises. You might for example 
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need to replace damaged parts, or you could be transferring quantities of 
stock to another site, or booking them out temporarily for some purpose. 

Choose the part number of the item you are booking out, using the 
record selector if necessary to help you identify the correct item. The 
current stock level for the chosen item is retrieved from the stock table 
and shown on the form. 

Enter the quantity to be removed from stock. Stockit will let you book 
out more than there is in stock (perhaps you know that there is an order 
due in today), but it will warn you first. 

It is also recommended that you enter a reference to help you identify 
the reason for the removal on stock movement reports (although this is 
optional). 

Once you are certain the the items details entered are correct, press the 
Book Out button to commit the Goods-Out to the database. The Book 
Out button will once again become ‘greyed out’ to show that the Goods-
Out action has been done and the Qty Available will be adjusted to 
reflect the reduced amount. The dialog will remain displayed to allow 
another item to be booked out. 

Making stock adjustments 
Stock adjustments may be necessary for a variety of reasons, but are 
most often needed after carrying out a stock check. Some of your stock 
items may not be showing the correct values for available stock, perhaps 
due to wastage with items you have to measure out, or because some 
items are damaged. 

The simplest way to adjust stock levels is to use the main stock form 
itself. From the Stores menu choose Stock. If you have carried out a 
stock check using the 'Parts By Location' report, it may help you to sort 
the stock form's grid into location order (by double-clicking with the left 
mouse button on the heading of the Location column) and work through 
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the stock in the same order as the report. Alternatively you can use the 
Finder box on the navigation bar to jump to the right part each time. You 
may also find it useful to drag the Stock column (which shows the 
current stock level for each item in the grid) from its default column 
position to a position further to the left next to the part number column 
so it is more easily visible. 

When you have selected the part you wish to adjust, press Enter to start 
editing. Select the ’Current Stock’ field and adjust the amount as 
necessary. Press Enter again to finish editing, then move to the next 
item to be adjusted and press Enter to edit the ‘Current Stock’ field for 
that item, and so on. You might find it easiest to use the arrow keys on 
the keyboard to move through the records until you arrive at the right 
one, or use the search dialog to jump directly to the required record. 

All stock level changes are recorded automatically as goods in or goods 
out records, with 'Adjustment' shown as the reference. 

Cancelling orders and order items 
Although you are reminded to be sure that your purchase orders are 
correct before they are actually ‘placed’, there are always going to be 
occasional problems that mean your orders need to be altered. Perhaps 
the supplier no longer stocks the item you’ve asked for, or they are out 
of stock and you can’t wait for stocks to become available. 

To cancel a complete purchase order or individual order items, choose 
Outstanding Purchase Orders from the Stores menu. On the 
Outstanding Order Items form that opens, choose the order item in 
question, then press the Cancel Order button. 

You can either cancel an individual item from an order, or an entire 
order. If there is only one item on the order then only the entire order 
may be cancelled. If the order has already had some items delivered, the 
Cancel Entire Order option changes to Cancel ALL remaining Items 
from Order. 
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If you are sure that the selected option  is what you wish to do, press the 
Proceed button.  

For cancelled items, the ‘quantity outstanding’ will be reset to zero, the 
‘quantity on order’ will be reduced by the cancelled amount and a note 
will be added to the item on the purchase order recording the amount 
cancelled and the date. The order itself will remain ‘in the system’ 
however if all remaining items are cancelled it will be moved to a 
‘Completed’ status. 

If an entire order is cancelled all of its order items are effective taken 
‘out of the system’ and the order itself is moved to a ‘Cancelled’ status. 
The order will remain in the Purchase Order History as a cancelled 
order where the original order details are accessible by double-clicking 
on the order in question. A note will have been added to the order 
recording the date it was cancelled. 

As orders or their items are cancelled they will be removed from the list 
of outstanding order items. If the order has been placed to satisfy 
shortages on a production job, cancelling order items will create a 
‘shortfall’ that will need to be satisfied from stock on a non-production 
order before production of that job can be completed. 
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Chapter 8. Parts Lists 

What is a parts list 
A Parts List is a collection of items (stock items, lines of text and blank 
lines) that go together to form another item. You can create a part list for 
example to define a set of components you use to build a product in your 
workshop, or to specify a list of items that your customers could buy as a 
‘kit’ for their own use. 

Every parts list has a stock item to go with it. The stock item defines the 
supplier (usually this is set to “FACTORY” to show that you ‘supply’ 
the item yourself from the constituent components), as well as being the 
place where information such as stock levels and costs for the completed 
unit are held. 

Products and assemblies 
A parts list is just a collection of items, as we have already described. As 
well as defining a complete product that you might build, they can also 
be used to define the components and instructions needed to build part of 
that product, or an “assembly”. The parts list for the product would then 
reference the stock item for the assembly as one of the items within it. 
This ability to reference one parts list from inside another is called 
“nesting”. There are no limits to the depth of this nesting, the only 
constraint is that Stockit won’t let you add an item to a parts list if that 
item already appears “higher up” the nested set of parts lists. 

Stockit makes no particular distinction between products and assemblies, 
other than our recommendation that you assign them to different 
categories when creating the parts lists for them. This allows you to 
change the way you use assemblies and products without having to make 
any changes within the Stockit database. The assignment to particular 
categories will simply help you “narrow down” the search when you 
come to use the parts lists. 

Creating a parts list 
Starting the parts list 

A parts list is created from the parts list form. From the Stores menu 
choose Parts Lists, or click on the Parts Lists button on the main 
toolbar. Press the Insert key, or click on the Add button on the parts 
lists form’s navigation bar. 
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When you have completed the overall parts list details, saving them by 
clicking on the Save button on the navigation bar that will also open the 
newly created parts list itself, ready for you to add items to it. 

Editing the new parts list 

If you have followed the tutorial section of this guide, you will know 
that the parts list form is divided into two areas. 

The top area shows the overall information for the whole parts list. The 
following fields within this area are editable: Description, Notes, 
Revision, and Date Costed. 

In the area below this, each line of the form will show an item from the 
parts list once some items have been added. When items are added, they 
are inserted above the currently selected row on the form, or above the 
first row on the form if no ‘item’ row is currently selected. At the end of 
the form is a single line across the width of the form; selecting this row 
before adding items will add them above this line, i.e. at the end of the 
form. 

Adding stock components 
Stock items are added by clicking on the Add Stock Component button 
on the navigation bar, or pressing the Insert key. 

The record selector is then used to select the required stock item. As 
stock items are chosen from the record selector, the description is copied 
from the stock item to the parts list item. Once added, however, the 
description is freely editable, allowing you to make minor adjustments to 
the description for this particular instance of the stock item. 



Stockit Users Guide 101 

The stock item referenced by a particular parts list item can be changed, 
by double-clicking on it with the left mouse button, or by selecting it and 
pressing the Edit (pencil) button on the form’s navigation bar. 

The quantity will default to 1 if you leave it blank. This will be done 
when the parts list is saved. 

Adding text items 
Text items (including blank lines) can be added by clicking on the Add 
Text button on the navigation bar. The text for these items can be freely 
edited by directly editing the text on the form. 

Removing items 
Items can be removed from the parts list simply by selecting them on the 
form and pressing the Delete key on the keyboard or clicking on the 
Delete (X) button on the form's navigation bar. 

Not-fitted parts 
Parts lists can also include items that are ‘not fitted’. You might want to 
do this, for example, if you have a particular part that is used to test the 
assembly you are building, but is not actually built into it.  

To specify an item as ‘not fitted’, simply enter zero for the quantity. You 
could edit the description to include ‘not fitted’ if you wish. 

Reference identifiers 

The ‘Ref’ field of a parts list item can be used to specify the identifying 
name of the particular item on the board. This could be used for example 
to identify individual components on a printed circuit board, but you can 
use it for whatever you need. 

Finding out where components are used 
Once you have more than just a few parts lists, it quickly gets very 
difficult to remember where particular stock items are used within those 
parts lists. Use the option Where Components Used on the Reports 
menu to scan the database for component usage in parts lists. 
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You can either search the database using a single complete part number, 
or by selecting the Where button you can match part numbers using a 
range of criteria. 

To carry out the search, press Find. The results are displayed on-screen 
in a report form. Each search is opened in a new report, so each time you 
press Find you will get a new report form. To close all the currently 
open reports, press the Close Output button. 

If the Indirectly Used box is checked, the report will show not only 
each parts list that uses the part(s) you are searching for, but also any 
parts lists that use those parts lists, and so on up the levels. 

Note: Depending on the size and complexity of your database, searching for 
‘indirect usage’ can be a slow process as it searches through all the 
parts lists and their contents. 
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Chapter 9. Production 

The production sequence 
The diagram below shows you the basic production sequence. Of course, 
depending on how many changes you make along the way, whether you 
request supplier quotes, and so on, you may well take a slightly different 
‘path’ through parts of this sequence. 

Order tracking 
Before looking at how to use the production features, it is worth 
mentioning at this point the Order Tracking features built in to Stockit.  

Order Tracking works by keeping track of the purchase orders against 
which, the stock items used in production, were received. This allows 
the program to keep you informed about the status of orders and 
deliveries for individual jobs and products and also allows the stock 
items used in those jobs and products to be traced back to the 
appropriate purchase order. Both items ordered specifically for a job and 
items used ex-stock can be tracked back to the originating purchase 
order. In addition to tracking purchase orders for stock items, this feature 
also tracks any sub-products that are built as part of the production job, 
tying these to the products into which they are incorporated by means of 
a unique individual serial number. So a complete thread of traceabilty is 
maintained through the complete product hierarchy. 
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The purchase order details of stock items and the serial numbers of sub-
products are displayed on the Assembly Lists that are available for the 
products and sub-products that are built by a production job. 

Order tracking options 
Stockit provides two alternative levels of order tracking; default or the 
more detailed ‘Track Orders on Individual Products’ which is set via the 
Options tab in the Options dialogue available from the Tools menu. 

Default Tracking 
With the default tracking, the whole quantity of a particular type of 
product in a job is treated as a 'batch', therefore products can be traced to 
the the purchase orders that were used for the batch of products of which 
they were part. If a job is building only a single product this will give the 
same degree of traceability as the second level of tracking.  

In addition to traceability, the level of order tracking used affects how 
the products within a production job are progressed through the 
production cycle. With the default tracking, products and sub-products 
will be moved through ‘releasing to production’ and ‘completing work 
in progress’ in batches, one for of each type of products or sub-products. 
Each batch will be assigned a unique serial number. 

Track Orders on Individual Products 

If this option is set, each individual product (and indeed sub-product) 
within a job is treated as a separate item, therefore each stock item used 
on each product or sub-product can be traced to the exact purchase order 
against which it was delivered. Also, each product and sub-product is 
progressed through ‘releasing to production’ and ‘completing work in 
progress’ as individual items each with its own individual serial number. 

Note:  It is recommended that you do not set Track Orders on Individual 
Products unless you really do need the individual tracking. With this 
setting enabled, the amount of data that needs to be stored in the 
database will increase, perhaps significantly if you build large quantities 
of items, and is thus likely to affect the performance of the system. 

Creating a production new job 
There are several ways of creating new production jobs. From the File 
menu, choose New, then select Production Job from the list of items 
displayed and press OK. This will display the 'jobs' form, primed ready 
to start entering the new job information. 

Alternatively, if you already have the jobs form open, simply click on 
the Add (+) button on the form's navigation bar to start adding the new 
job. 
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Additionally, a new job can be created by copying an existing one. From 
the Production menu, choose Jobs. Select the job you wish to copy, and 
then click on the Copy button on the job form’s navigation bar. The new 
job will be created by copying the details from the selected one, 
including its ’Mix of Products’. 

Once you have finished entering the overall job details, click on the 
Save button on the navigation bar and the job will be saved. The Mix of 
Products form for the new job will then be automatically opened ready 
for you to specify the product(s) to be built with this job. 

Editing the mix of products 
The mix of products will list the products (and/or assemblies) that you 
plan to build for a job. To choose your mix of products, simply add the 
required quantities of each parts list to the mix of products form. 

To add an item to the mix, press the Insert key to open the Record 
Selector to choose from the available parts lists. Find the parts list you 
wish to use, and then press Enter to add this to the mix. Then type in the 
quantity you wish to build, and again press Enter.

The record selector will open again ready for you to add the next item. 
Continue choosing parts lists to add to your mix until you have all the 
items you need, then press Esc to cancel the record selector dialog. 

If you need to remove an item from the mix, simply select the required 
item and click the Delete (X) button on the mix form’s navigation bar. 

Quantities can be changed simply by clicking on the existing quantity 
and editing the value. Similarly, if you want to change one of the items 
to reference a different parts list, double-clicking on the part number will 
open the record selector to allow you to choose a different parts list. 

When you have all the items you need in your mix of products, click on 
the Save button to save the changes, and close the mix of products form. 



106 Stockit Users Guide  

The active job 
Stockit allows you to create multiple production jobs even at the 
planning stage. You can have as many jobs as you wish at any stage of 
the production cycle. This said, many of the production options need to 
operate on a single job at a time. This job is known as the ’active job’. 
The active job is shown at the right-hand end of the status bar. To 
change the active job, open the jobs form (if not already open) by 
selecting Jobs from the Production menu, then simply select the 
required job in the grid on the form. 

If you drop down the Production menu, you can see the options that use 
the active job listed in the middle block of the menu, under the active job 
number. 

The active job only applies to your copy of the program. Changing your 
active job doesn’t affect anyone else, and doesn’t change anything in the 
database. The database is only changed when you carry out actual 
operations using the active job. 

Job and Product status 
At any time the current status of a production job may be checked from 
the Jobs form where it is displayed in the Job Status column. The Jobs 
form is available from the Production menu. The possible values for the 
job status are:- 

• Created 

• Trial Kit 

• Allocated and Awaiting Orders 

• Allocated 

• In Production 

• Completed 

• Cancelled 

The products being built by a given production job also have status that 
reflects the position of that particular product or batch of products (or 
sub-products)  in the production process. The product status may be 
checked at any time in the Production History, also available from the 
Production menu, where it is displayed in the Production Status 
column. The possible values for the product status are:- 

• Checking Stock 

• Stock Allocated 

• In Production 
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• Completed 

• Cancelled 

Note: Where a production job contains multiple products (and/or sub-
products) which are at different stages of production, the job status will 
reflect the least advanced of the products. 

Checking stock implications 
Before moving a job forward from planning to production, the 
availability of the required stock needs to be checked. In fact, this is 
perhaps the most important stage in the production cycle, as the ability 
to test the requirements of the job against available stock allows you to 
perform ’what if’ predictions as part of your production planning. You 
might for example want to adjust the mix of products until the quantities 
planned fit with the available stock, or until the overall cost fits with 
your requirements. 

Once you have edited, saved and closed the mix of products for the job, 
click on the Check Stock button on the jobs form or the main window 
toolbar, or choose Check Stock from the Production menu. 

The parts list for each item in the mix of products is used to create a list 
of stock items needed for the job. The quantities of any stock item used 
in more than one parts list in the mix of products will be consolidated, so 
that any one stock item only appears once in the list of required items. 
Any parts list marked as ’auto expand’ will be expanded and the stock 
items it contains added to the list, rather than simply adding the parts list 
as a single stock item. The auto expand facility operates hierarchically 
such that any auto expand parts list referenced within another auto 
expand parts list will also be auto expanded to its constituent stock 
items. 

The quantities required for each stock item is then checked against the 
available stock, and any shortage is noted. These shortages are shown in 
the shortages form. Each job has its own list of shortages, and you can 
have several jobs at this initial ’trial kit’ stage in the production cycle. 
This does allow you to plan several jobs at once,  or even try several 
different production scenerios simultaneously, although some care is 
required if you are doing this because each ’planned’ job at this ’trial kit’ 
stage takes no account of the requirements of the other jobs also having 
’created’ or ’trial kit’ status (see Shortages re-checked below). 

The shortages form 
The shortages form for a job shows the currently calculated list of 
shortages for the job. This takes into account available stock, which is 
the quantity currently in stock less any amount already earmarked for 
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other production jobs, but does not automatically assume that items 
already on non-production orders are available for production. 

Review shortages  
If you have already checked the stock implications of a job the Check 
Stock option changes to Review Shortages. Using this option will 
simply re-display the existing shortages list for the job.This allows any 
adjustments that may have been made to the shortages to be preserved 
even if the shortages form is closed and re-opened later. Shortages are 
only re-calculated if you explicitly choose to do so, or if you change any 
of the shortages options that necessitate a recalculation (such as 
Expand), or if changes in the database would render the shortages 
incorrect (such as when the mix of products had been modified). 

How shortage amounts are calculated 

The drop-down list in the top part of the shortages form shows how the 
shortages are calculated from the list of stock items required for the job. 
To change the method, drop down the list and choose the required 
setting. When a new setting is chosen, any existing shortages are 
discarded and the shortages are re-calculated according to the new 
setting. 

Check against zero stock levels : the required quantity of each stock 
item is compared to the current quantity in stock. Any deficit is reported 
as a shortage for that item. 

Check against min stock levels : any Minimum Level defined for a 
stock item is excluded when considering the current quantity in stock. 
The minimum amount is assumed to be a ’buffer’ stock that is not 
available for production. This is the default setting. 

Check against min and replenish all : this calculates shortages using 
the same method as Check against min stock levels, but also includes 
any item whose stock level has fallen below the defined Minimum 
Level regardless of whether or not it is needed by this production job. 
This setting provides a means of replenishing stock at the same time as 
generating production orders. (Also see the section on ‘Replenishing 
stock levels’ under the chapter on Purchasing) Ignore current stock 
levels: this will generate a complete set of shortages for exactly the 
required quantities of each stock item in the job, regardless of the current 
stock levels. This setting may be useful when used in conjunction with 
the  ‘Pre-ordering for production jobs’ feature described later in this 
chapter. 
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Expanding parts lists 
Parts lists are stock items like any other, so they can appear in the list of 
shortages just like individual components. Parts lists are identified in the 
shortage form by an X in the column that is also headed X, to indicate 
that these are ’expandable’ items. 

If you want to build the shortage item represented by the parts list as part 
of your production job, you can expand the parts list to its constituent 
items and include those items themselves in the shortage calculations. 

As we mentioned in the section on ‘Checking stock implications ‘ parts 
lists whose stock items are marked as ‘auto expand’ will be 
automatically expanded.  Those not marked as ‘auto expand’ may still be 
manually expanded from the shortages form. 

To do this, select the appropriate shortage item in the list, and click 
Expand (or double-click the left mouse button on the shortage item). 
The parts list will be removed from the shortages, expanded to its list of 
items, and the shortages for those items calculated and added into the 
existing set of shortages. 

If you wish, you can expand all the parts lists in one go, by pressing the 
Expand All button. Each one of the expandable items in turn is 
expanded and the shortages calculated or adjusted. This option operates 
hierarchically such that any parts list referenced by another parts list will 
also be expanded to its constituent stock items. When this option has 
completed, the shortages will contain only the non-parts list stock items. 

You should also be aware that the cost shown at the top of the shortages 
form could decrease when you expand parts lists, as any ‘unrestricted’ 
items (build time etc) are taken out. 

Outstanding non-production orders 
The shortage calculation doesn't take into account any outstanding non-
production orders, only the currently available stock. 

However, as a guideline to stock that may be available in the required 
timescale, any shortage item that is also an outstanding purchase order 
item is marked with O in the column also headed O.

Double-clicking in this column will open the Outstanding Order Items 
form, showing you the quantities that are expected for this item, and any 
required or expected delivery dates. Note that this may include purchase 
orders from other production jobs if those orders include a amount not 
specifically for that job, perhaps because the item had to be ordered in a 
specific pack size. 

You may decide that you can reduce your production shortage amount 
and use some of the non-production stock for your production job when 
it arrives. 
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If you do this, Stockit will help you to keep everything ‘in line’, by 
recording the fact that there is a ‘shortfall’ between the amount ordered 
for the job, and the amount required. This shortfall will then be 
‘satisfied’ by automatically allocating non-production stock as it is 
received through goods in. 

Adjusting shortages 
Although the Check Stock option calculates the amounts to be ordered 
for the various stock items needed for your production job, it may 
sometimes be necessary to make some adjustments to the resulting 
figures. 

The amounts calculated for ordering will take into account any minimum 
order quantities and pack quantities, but you might wish for example to 
increase the order amounts to cater for intended future production. You 
may also know that a particular item is out of stock with your usual 
supplier and so wish to specify an alternative supplier for that item. 

Click on the Adjust Shortages button on the shortages form or the main 
window toolbar, or choose Adjust Shortages from the Production 
menu. 

On this form, select the shortage item to be edited in the grid and click 
the Edit button on the form’s control bar or press <Enter>. Alternatively, 
double-click the item. You may then edit the ‘Qty to Order’ for the 
shortage item (including setting it to zero), and specify an alternative 
supplier by selecting from the Supplier drop down list, or choosing one 
using the record selector. You can also add new items to the list of 
shortages by clicking on the Add (+) button the navigation bar and 
choosing the required item using the record selector. 

Existing shortage items can not be deleted but using the Delete (X) 
button will set the ‘Qty to Order’ to zero indicating that none of the item 
is to be ordered. 

Item Notes 

Notes for individual shortage items may be added using the Notes field 
on the Adjust Shortages form. These notes will be carried forward on to 
the purchase orders generated when the job is allocated and could be 
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used to specify information such as special delivery details on a item by 
item basis.  

Tip: These notes should not be added until you are sure about the make up of 
the shortages as re-calculating, either explicitly or implicitly, will cause 
all adjustments including these notes to be discarded. 

Recalculating shortages 
Shortages can be re-calculated at any time. For example if you know the 
prices of a number of stock items have been changed, this might affect 
the overall cost of your production job. 

To recalculate the shortages for a production job, first make sure the job 
you want to work on is the ’active job’ (shown on the right-hand end of 
the status bar). Then click on the Recalculate button on the shortages 
form. 

Current shortages discarded 
It is important to realise that when re-calculating shortages, the current 
shortage list is cleared before being re-built from the original mix of 
products. 

Any changes you have made since the original shortages were calculated 
(including expanding parts lists, or adjusting shortage amounts or 
suppliers) will be lost when the new list of shortages is re-calculated. 

Requesting supplier quotes 
Before committing to placing orders and reserving ex-stock items, you 
may need to request up-to-date prices from your suppliers. From the 
Shortages form, click on Quotes. This will create a set of supplier quotes 
for all the current shortage items, which you can then print off and send 
to your suppliers. 

Allocating stock and placing orders 
Once you have decided to commit to building the production job, the 
next stage is to allocate the necessary ex-stock items and place orders on 
your suppliers for the shortages. 

Up to this point, no stock levels will have been changed and no orders 
placed, so you are free to go back and modify the mix of products, re-
calculate or adjust shortages, or indeed to cancel the entire job if you’ve 
changed your mind about building it at all 
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Once allocated, you may still cancel the job and any placed purchase 
orders, but these will stay on record as having been placed and then 
cancelled. 

From the Production menu choose Allocate Stock/Orders (or click the 
Allocate button on the main window toolbar or the shortages form). 

Shortages re-checked 
Before the allocation can take place, the shortages for the job are re-
checked, to make sure that stock items that were available when the 
shortages were generated are still available. 

If some items that were being used ex-stock that are no longer available 
in the required quantities, a message will appear to tell you this, and you 
will need to go back to the shortages form and review or rectify the 
situation. 

Confirming the allocation 

Committing a production job using Allocate sets off a number of 
database changes, so you are asked to confirm that it is okay to do so by 
clicking on the Proceed button. 

If you are not sure, and you need to review the mix of products or other 
information, press Cancel to close the dialog without further action. 

Purchase order dates 
If you wish, you can specify the ‘Required Date’ and/or ‘Expected Date’ 
to be put on the purchase orders as they are generated. The ‘Required 
Date’ is how you tell your supplier the date by which you need these 
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items delivered, and the ‘Expected Date’ is used for your information to 
record the date when the order is expected to be delivered. 

If you don’t want either of these dates on the purchase orders generated, 
leave these fields blank. You can always set them afterwards on an 
order-by-order basis if you need to. 

Booking in deliveries 
Deliveries for your production purchase orders are booked in using the 
Goods In option on the Stores menu, as described in “Order-based 
Goods In” on page 92. 

Releasing stock to production 
The next stage in the production cycle is to issue the necessary stock 
items from stores to be used in the production of the product(s) in the 
job. 

From the Production menu, choose Release to Production. The form 
that opens will show you a list of the products from jobs that have been 
allocated, but have not yet been released. 

Select the product you wish to release to production, and click the 
Release button. The status of any purchase orders for the job is checked, 
to see if there are any production orders still to be delivered. Outstanding 
order items relevant to the product being released will be individually 
reported as will any still outstanding ‘shortfall’ quantities that were 
intended to be satisfied by pending non-production orders when the 
shortages were adjusted. 

If the product has ‘sub-products’, i.e. parts lists that were expanded 
while checking stock implications (including ‘auto expand’ items), the 
status of those sub-products is also checked and any still to be completed 
will be reported. 

A check is also made at this point that the amount of items actually in 
stock at this point is sufficient to meet the quantity allocated to the 
product to be released. It is possible that the actual stock level may have 
diminished since allocation, perhaps due to a stock take adjustment or a 
unplanned withdraw of stock through Goods Out. 
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If all the necessary items have been delivered, completed or were 
already and are still available in stock, the message that appears will tell 
you that this item is ready to be released. You can then press Release to 
continue, or Cancel if you have changed your mind. 

Releasing before all stock is available 
If there are outstanding purchase order items against this job or product, 
then the message that appears will tell you what is still outstanding. 

 

You can still choose to release to production anyway, as you might for 
example be able to start building the product, and not be delayed by the 
lack of some parts that will only be needed right at the end of the build 
process. Stockit can’t work this out for you, but it will let you use your 
judgement on whether or not to continue. 

If you do choose to continue by pressing the Release button, you may 
find that current stock levels of some stock items have negative values 
until the expected deliveries are actually received through goods in. 

Work in progress 
The products currently ‘in production’ are termed ‘work in progress’. 
Once a product is released to production, as far as Stockit is concerned it 
becomes ‘work in progress’ even if you haven’t actually started 
physically building it yet. 

Choosing Work in Progress from the Production menu will display a 
form showing all the products currently in production. This form shows 
you the job and serial numbers of each product, the quantity being built, 
and the relevant dates. An S in the Sub column indicates that the item is 
a ‘sub-product’ that is being built to go into another product being built 
in the same job. 
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Completing a job 
When you complete a batch of products corresponding to one of the 
rows on the Work in Progress form, select the row and click on the 
Complete button. Stockit will check whether or not all relevant 
outstanding order items have been received and whether all relevant sub-
products have been completed. 

A small report dialog appears to allowing you to confirm completion: 

The completion date has an initial value of today’s date, but you can 
change this if you wish. You can also choose whether or not the 
completed items should be added to stock. If the item to be completed is 
a sub-product, the option to add the completed product to stock will not 
be available as the sub-product will be incorporated into one of the other 
products in the job. 

If there are outstanding orders or sub-products, the report dialog gives 
you information about what is still outstanding: 

Cancelling a job 
A job can be cancelled at any stage before stock has been released to 
production. From the Production menu choose Jobs, select the job you 
wish to cancel, and press the Delete (X) button on the form’s navigation 
bar. 

If the status of the selected job allows it to be cancelled, a confirmation 
dialog that appears will warn you what is about to happen, and give you 
the opportunity to change your mind by pressing Abort, or confirm the 
job cancellation by pressing Proceed.
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You may have already placed orders against this production job, or 
indeed may have received some or all of those orders into stock. Stockit 
takes care of this for you by ‘unhooking’ those purchase orders from the 
cancelled job, effectively allowing the received items to become 
available as if they had been ordered on a non-production order. 

Ex-stock items that had been reserved for the job by allocation will be 
un-allocated, freeing them up for use by other future jobs. 

The job itself will remain in the Production History as a ‘cancelled’ 
job. 

Pre-ordering for production jobs 
As well as placing ‘true’ production orders for a job, it is also possible to 
generate the set of order items required for a job and place non-
production orders instead. You may want to use this option if you need 
to pre-order items on long lead times, well ahead of when they would 
actually be required for production. 

The Pre Order for Job option on the Stores menu takes the list of 
shortages for the active job, and generates the corresponding list of non-
production order items. 

This option may be most useful when used in conjunction with the 
‘Ignore current stock levels setting’ on the shortages form. 
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Chapter 10. Finances 

Updating stock prices 
Stock prices can be updated directly in the stock form, or by using prices 
set for items received through goods in. 

Updating unit cost on stock form 
For occasional changes to unit costs, it may be sufficient to update them 
directly through the stock form itself. 

From the Stores menu choose Stock. Find the stock item for which you 
need to modify the cost, click on the Edit (‘pencil’) tool on the form’s 
navigation bar (or press Enter on the keyboard), and simply change the 
unit cost on the form and press Save (or Enter again) to save. 

Updating through Goods In records 
From time to time you may wish to update your prices across a range of 
stock items to more closely reflect the current buying price of these 
items. This can be done by applying prices set in your goods in records. 

Before applying the goods in costs, clearly these need to be set up. You 
can either do this at the time the goods are booked in, or as a ‘batch’ 
operation across a set of goods in records, or a combination of the two. 

Setting costs when booking goods in 
When booking items in through goods in, the ‘goods in details’ dialog 
provides you with a box you can use to enter the cost (if this is shown on 
the delivery paperwork). 
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This will need to be done for each item received, so clearly it depends on 
the availability of the information on the paperwork, the time available 
to fill in this information on the dialog, and indeed whether or not you 
want your goods in department even seeing the cost information. 

Setting costs after booking goods in 
It may be more appropriate to set up the costs as a separate task, perhaps 
by one of your accounts staff, rather than at the time the goods are 
actually booked in. You may also only have this information to hand 
once the supplier invoice has arrived. 

From the Financial menu, choose Set Goods In Costs. The form that 
opens will show you a complete list of all goods in items in the database. 
You can use the normal ‘filter’ tool to reduce this to a more recent list if 
you wish (by choosing ‘Date Received’ ‘Greater Than’ the required 
date). 

You can now use this form to update the prices as necessary from your 
source information. Find the goods in item you wish to change, and 
press Enter on the keyboard or the Edit (pencil) button on the 
navigation bar to start editing. Enter the new unit cost, and press Enter 
again to finish. 
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The ‘calculator’ button alongside the unit cost field will open the 
calculator dialog to help you calculate unit cost from pack cost and 
quantity. 

Applying goods in costs 
Regardless of how the goods in costs are set, to apply them to the stock 
table (or review what would be changes would be made if you did apply 
them), choose Update Stock Prices From Goods In Costs from the 
Financial menu. 

The dialog that opens provides you with a number of options controlling 
how the costs should be updated. 

The first part of the dialog allows you to include all goods in records, or 
only those recently received. 

The calculation that is done to arrive at the new Unit Cost is also 
controllable, using the three options in the middle of the dialog. The first 
two options use a ‘weighted average’, the last will simply use the 
maximum unit price it finds. 

The last area of the dialog allows you to control what is shown in the 
report that is generated. 

To produce a report of the price changes that would be done, click the 
Preview Price Changes button. This generates a report listing all the 
price changes that would be applied, but doesn’t actually apply those 
changes. This allows you to check for example that no typing errors 
have been made in entering goods in costs. 
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The example report below shows that the prices of three of our stock 
items would be updated, and also shows you how much the price will 
change. 

Note: Although the report appears ‘behind’ the dialog, you can click in the 
report and scroll or resize it to see all the information. 

When you are ready to commit to applying the price changes, click on 
the Update Prices button to change the actual stock record prices. 

Updating parts list prices 
The cost of a parts list is held in the corresponding stock record. 
Although individual parts lists can be re-costed while editing the actual 
parts list contents, if you have even a relatively small number of parts 
lists then this would be a time-consuming operation. To automate this 
task, there is a separate option that deals with updating the cost for parts 
lists. 

From the Financial menu, choose Update Parts List Costs. The dialog 
that opens should provide you with the tools you need to re-calculate the 
cost of any or all of your parts lists. 

The upper part of the dialog allows you to specify how to choose the 
parts lists to be updated. 

When set to ‘Selected Parts Lists’, the list box shows a list of all parts 
lists in the database. Use this mode to update the costs of particular parts 
lists (or indeed all of them). 
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When set to ‘Parts Lists Containing’, the list box shows stock items that 
are not themselves parts lists. Use this mode to update the cost of any 
parts lists that might be affected by changes in particular stock items. 
For example, if you change the price of a single stock item, there is no 
real need to re-cost all parts lists, so by choosing this mode and selecting 
only that stock item from the list, only those parts lists that contain the 
stock item will be updated (along with any that in turn contain those 
parts lists, and so on). 

Depending on the size and complexity of your database, you may well 
find that it is just as easy to select all parts lists and update the costs of 
them all in one go, as this is usually such a quick operation that there is 
no point taking time to make select complex combinations of parts to be 
updated. 

When you have chosen the mode you wish to work in, and selected the 
items to be re-costed or used, click Update Cost to update the affected 
parts list costs in the stock table. 

Listing the cost of parts lists 
The Report Parts List Costs option on the Financial menu is a shortcut 
to the Parts List Costings report. You can choose to filter the report 
based on part number, category or unit cost (as described in “Pattern 
matching” on page 124), then the report is displayed on the screen. 

The report shows the parts lists in the database, together with their cost 
as currently calculated, and when that cost was last updated. 

Stock valuation 
The stock valuation report allows you to quickly find an approximate 
value for the stock you are currently holding. This might be needed for 
example if you are completing your end-of-year accounts and require a 
value for your current stock. 

From the Financial menu, choose Stock Valuation. The report that 
opens will list the values of items held in stock (including those already 
allocated to production), items already in use in production (work in 
progress), and also the value of outstanding purchase order items. 
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The value of stock is calculated on a ‘replacement cost’ basis, using the 
unit cost of each stock item as the current buying-in cost of that item. It 
does not take account of historical value of stock previously bought at 
lower prices. 
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Chapter 11. Reports 

The Reports dialog 
Choosing a report 

The Reports dialog is opened by choosing More Reports from the 
Reports menu. Some of these reports are also available directly from the 
Reports menu itself, in which case only the right-hand part of this 
dialog will be displayed.  

Choose a report by clicking on its name in the list of reports at the left-
hand side of the dialog.  

Selecting data to be included 
On the right-hand part of the dialog (which will be the only part 
displayed if a report was chosen directly from the Reports menu), a set 
of controls allows you to selectively choose data to be included in the 
report. You can apply various filter criteria to the data, based on the field 
shown in the ’Where’ drop-down list. The fields available in this list will 
depend on the report you have chosen, as the list will only show fields 
relevant to that particular report. 

If you want to display a complete report containing all the relevant data 
from the database, then the criteria fields should be left blank. (The 
setting in the ’Where’ drop-down list is only used if there are values in 
the box (or boxes) below). 

From the ’Where’ drop-down list, choose the field on which you want to 
filter the information. 
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Having chosen the field on which you want to filter, the second drop-
down list allows you to choose how to actually filter the values found in 
that field. You can choose one of the following settings: 

• Between - the chosen field is between two values. 

• Like - the chosen field matches a range of values based on a ’pattern’ 
(see below). 

• Is - the chosen field is exactly a particular value. 

• Greater Than - the chosen field is greater than a particular value. 

• Less Than - the chosen field is less than a particular value. 

Depending on the setting you choose, you will need to enter one or two 
values in the boxes provided. ’Between’ requires two values, whereas the 
others require one. In the example shown below, we have chosen to 
include all records where the Supplier is between A and F. 

Pattern matching 
When you choose ’Like’ from the drop-down list of settings, the value 
you enter in the edit box can include "wildcard" characters. These allow 
you to match a range of values that fit a particular pattern. Two wildcard 
characters are recognised, * and ?. Some examples of wildcard patterns 
are shown here: 

Pattern Matches all records where: 

AX* first two letters are AX, followed by any number of 
characters (including none). 

A?2 first letter is A, second is any single character, last is 2. 

*PP* letters PP appear as a pair, with zero or more characters 
before and/or after. 



Stockit Users Guide 125 

Viewing and printing 
When you have chosen the filter criteria you wish to apply (if any), the 
report can be viewed on-screen by pressing OK.

If there are no suitable records in the database, or none matching the 
criteria you have selected, a message appears telling you there are ’No 
records to display’. 

If there are some records to include in the report, it will appear on the 
screen. If you want to see what it will look like when printed, choose 
Print Preview from the File menu. To print it out, simply choose Print 
from the File menu, and print using the standard Windows Print dialog 
that appears. 

Available reports 
Stores 

Labels - "bin" labels for marking items in stores. Includes pre-formatted 
report to fit Avery standard labels. 

Movement - two reports covering stock inputs and stock movements. 

Parts list - parts list forms. 

Picking list for parts list - stores picking list for picking items needed to 
build a parts list. 

Stock by category - stock items sorted by their category. 

Stock by location - stock items sorted by their physical location. 

Stock by part number - stock items sorted by their part number. 

Stock by supplier - stock items sorted by their supplier name. 

Stock by supplier part number - stock items sorted by their supplier part 
number. 

Stock levels by part number  - current stock levels, sorted by part 
number. 

Suppliers - supplier records. 

Orders 
Orders - order forms. 

Outstanding orders - order items currently outstanding. 

Order history - current and old purchase orders. 

Request for quote - request quote for non-production order. 
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Production 
Assembly list  - two styles of manufacturing assembly lists. 

Mix of products - listing mix of products for production jobs 

Picking list - picking lists for products or jobs in two different styles. 

Request for quote - request quote for production order. 

Awaiting Non-Production – details stock items not on production order 
currently being awaited by production jobs. 

Financial 
Stock valuation - value of stock in hand, on order and in production. 

Stock price update variance - "before and after" report of stock price 
changes. 
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Chapter 12. Advanced Tasks 

Backing up the database 
Stockit includes an integrated backup and restore facility for increased 
security. The common saying “time is money” is very relevant when you 
think of how much time it would take to re-enter all your stock 
information from scratch – even if you actually had all the information 
you needed. 

Adding Stockit database to your own backup 
If you already have a scheme in place for backing up your work for your 
other software, you should add the Stockit database file into this backup. 
All the Stockit information is held in the single database file, so you will 
only need to make a backup copy of that one file. 

Using automated backup 
If you don’t already have a backup scheme (which you should seriously 
consider setting up), or if you want a ‘belt and braces’ setup, Stockit 
includes the ability to take an automatic copy of the database file for you 
according to various settings. 

Setting automated backup options 
The frequency and destination for automated backups is controlled by 
settings on the Backup page of the Options dialog, which is in turn 
accessed from the Tools menu. 

The setting for the backup interval is stored in the database itself, so that 
everyone using the database follows the same rules for how often it 
should be backed up. 



128 Stockit Users Guide  

The location is stored in the system registry on each computer, allowing 
the backup to be written to the most appropriate place according to 
which computer Stockit is running on. 

When does the backup happen? 

The database is backed up according to the settings in the ‘When To 
Backup’ section of this dialog. It is recommended that you only use the 
setting ‘Never’ if you are making your own backup copy. 

As you quit the application and close the database, the backup settings 
are checked to see if a backup should be attempted. If set to happen ‘at 
intervals’, the date of the last backup is also checked. If a backup is 
needed, you are prompted to confirm that a backup should be done. 

If you are running in a multi-user configuration, an automated backup 
will only take place if the program can gain ‘exclusive’ access to the 
database. 

Where does the backup go? 
The backup copy of the database file has the same name as the database 
you are backing up, with the words “Backup copy of “ added at the start 
of the name. 

The folder in which the backup file should be stored is specified on the 
Options dialog page. This could be the same folder as the database file 
itself, or (perhaps a better option) a folder on another computer in case 
your computer hardware fails. 

Restoring the database 
Sometimes it might be necessary to restore a backup copy of the 
database. Doing this will ‘wind the clock back’ to the point at which the 
backup copy was done. Any changes made to the database since the 
backup would then be lost, so you should only restore an earlier copy of 
the database if you are really sure that this is what you want to do. 

If you should ever need to reload a backup copy of the database for any 
reason, there are two methods or procedures for doing this. 

Restoring using Stockit 

If you are running Stockit, you can select Restore from the Tools menu, 
browse to the saved copy of the database file, and restore it “over the 
top” of the existing database file. 

Stockit will need close any forms that you have open before the Restore 
can take place, so that the existing database file can be closed before it is 
overwritten. 
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If you are running in a multi-user configuration and there are two or 
more people logged into the database then Restore will not operate. You 
will see a warning message that Stockit was unable to gain ‘exclusive 
access’ to the database file. You will need to get the other user(s) to 
close their copies of Stockit before you can use Restore. 

Restoring outside Stockit 
Although it is in theory possible to restore the database outside Stockit’s 
control, this should really be avoided. You should instead use the 
Restore option provided for that purpose within the Stockit program. 

It is actually possible to overwrite a database file that is still in use by 
other instances of the Stockit program, potentially causing them to quit 
unexpectedly or even to cause data corruption. 

Moving the database 
The name of the database file that your copy of Stockit uses is defined 
on the Locations page of the Options dialog, which can be accessed 
through the Tools menu. 

Making a copy of the database 
The first step in moving the database is to copy the existing file to the 
new location. 

To do this, you can either use the Backup option on the Tools menu to 
save a copy, or you can use the Windows Explorer to copy the database 
file itself. 

The first method is the one we recommend, as it makes sure that you 
have ‘exclusive’ access to the database, preventing any possible loss of 
information that might otherwise happen if there were several people 
still writing to the database file when you copied it. You should only 
take a ‘file copy’ of the database if you are sure no one is using it at the 
time. 

Switching to a different database 
Once you have made a copy of the database, you will need to switch 
your copy of Stockit to use the new file. The database path that you need 
to change is defined on the Locations page of the Options dialog. 

There are two database locations on this dialog. The first is for the main 
or ‘real’ database that you use for ‘live’ stock information. The other is 
for the tutorial database that you can use to learn how to use Stockit or to 
try out features without affecting your main database. 
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Note: If you are running a demonstration copy of Stockit, this will only access 
the Tutorial database. 

To change your copy of Stockit to read a different database file, click on 
the Browse button alongside the current database name. 

Use the standard Windows file browser to locate the database file you 
want to use instead of the current one, and press Open. When you press 
Apply or OK on the Options dialog itself, the current database and any 
open dialogs and forms may be closed, and the new database opened. 

Note: Tutorial and Main databases are not interchangeable. If you browse for 
a main database and choose a tutorial database file, Stockit will report 
an error and ask you to try a different file. 

Importing data 
Stockit / Stockit Professional 

Importing data from Stockit DOS-based products (Stockit and Stockit 
Professional) is described in “Importing the data” on page 138. 

Stockwin 
Importing data from Stockwin is described in “Importing the data” on 
page 139. 

Other systems 
Data can be imported from other systems using files known as “comma-
separated value” or “CSV” files. These are text files present the data as 
lines of information, usually one line per record with each field on the 
line separated by a comma. 

Data can be imported in this way into the Stock, Suppliers and 
Categories tables of a Stockit database. From the File menu, choose 
Import, then Import Wizard. Press Next to move to the page called 
‘Type of Data’ and select “Comma Separated (CSV) File”. 
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The following pages of the Import Wizard then allow you to choose the 
file to import, and also database table into which the file should be 
imported together with a mapping of fields in the import file to fields in 
the database table. 

For more details on exactly how to use this feature, open the Import 
Wizard and then press F1 to access the relevant online help pages. 

Exporting data 
Comma-Separated Value (CSV)  

Any form that contains a grid can be exported to a comma separated 
(CSV) file. From the File menu choose Save As, and then choose CSV 
Files from the drop-down list ‘Save as type’. 

All the currently visible columns of the grid will be exported as fields on 
each record in the file, so you can control what items you export by 
using the Customise Grid option to hide or display the necessary fields. 

See “” below for options that apply to exported CSV files. 

Rich Text Format (RTF) 
Any form that contains a grid (including ‘paper-style’ forms such as 
purchase orders) can be exported as a Rich Text Format (RTF) file. This 
file, which should be readable in many word processing applications, 
should give a good representation of the on-screen appearance of the 
grid or form. 
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As with CSV output, use Save As on the File menu, and choose ‘Rich 
Text Format’ as the output type. 

Options for exported files 
On the Options dialog (accessed from the Tools menu), the Options 
page has some settings that apply to exported files. 

Output field names 
When exporting tables as CSV files for import into other applications, it 
is generally a good idea to include the field names as the first line in the 
exported file. This might help the ‘receiving’ application to interpret the 
file correctly, or simply help you understand which column is which. 
Some tables (stock items, for example) have a number of fields that 
would otherwise be indistinguishable (e.g. many ‘quantity’ values). 

If you are exporting data to be modified and then re-loaded into Stockit 
using the Import Wizard, including field names should allow Stockit to 
map the fields in your re-imported file onto the corresponding database 
table fields automatically. 

Set this switch to output field names. Clear it to leave them out and only 
write ‘data’ records to the output file. Field names are written to the first 
line of the output file as text items enclosed in double quotes. 

This option only applies to CSV files. 

Send to application 
You have the option of opening the exported file in the associated 
application for this type of file (if your system has one defined). For 
example, exporting an RTF file could launch Microsoft Word if installed 
as the default application for this type of file. 

If no application is set up to handle the type of file you are exporting, 
setting this switch has no effect. 
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Chapter 13. Networking and Multi-user 
Configuration 

Supported networks 
Stockit uses the Microsoft Jet database engine that only requires 
‘standard’ file access to the database file. Any network that allows file 
sharing from normal Windows applications should be suitable for use 
with Stockit. 

Networking overview 
Database and software 

Program and database files should be installed in shared folders that are 
accessible to all network users who will need to run Stockit. All these 
users will also need read/write access to the database folder. If they only 
have read access, Stockit will ask if you want to make the database file 
writeable each time the application is started, which of course it will not 
be able to do. 

Users and groups 
Each person who needs to use Stockit should be given a username and 
password. Some usernames could be ‘generic’, for example if there is a 
single computer in despatch that is used by several people then the 
username could be ‘despatch’. The only restriction is that any username 
cannot be logged into the database more than once. 

The procedures for creating user and group names is described in “User 
configuration” on page 135. 

Locking 
To allow true multi-user operation, Stockit uses several levels of 
“locking” to control access to different areas of the database and avoid 
conflicts between users attempting to modify the same data. 

This is all done without any specific action required by the user, except 
in the occasional case where you try and access something that is locked 
by someone else. In this case you generally have the opportunity to 
‘retry’ (in case the required resource is only briefly locked and is now 
available) or to ‘cancel’ the action you were trying to carry out. 

Although the locking is carried out without needing any action from the 
user, the various ‘levels’ of locking are described below so that you can 
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understand the implications of any lock conflicts that might happen from 
time to time. 

Database lock 
The ‘highest’ level of lock is the entire database. Few operations require 
‘exclusive’ access to the database, generally only those that have a 
widespread effect on the database file. These include Backup, Restore,
converting from an earlier database format, and the Maintenance tools. 

Table lock 

A few operations need to work on entire database tables, but these are 
kept to a minimum to avoid unnecessary disruption to other database 
users. 

Object lock 

Operations on production jobs, purchase orders and parts lists generally 
lock the ‘containing’ object (the job, order or parts list) for the duration 
of their operation. 

Record lock 

Every time any changes are written back to a database that is not already 
locked, the particular record that is being changed is locked to prevent 
multiple concurrent ‘writes’. 

Avoiding lock conflicts 

To avoid possible lock conflicts, where you could prevent other users 
from accessing parts of the database by keeping hold of locked resources 
for too long, it is recommended that you don’t keep the following open 
for longer than necessary: 

• Parts Lists 

• Mix of Products 

• Purchase Orders 

Recovering from ‘stuck’ locks 

It is possible that for some reason an item remains locked when it should 
have been released. Refer to “Locking” in the “Trouble Shooting” 
section on page 143 for details on how to recover from this situation. 

Installation 
Multi-user installation is described in full in “Installing for multi-user 
operation” on page 22.  
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User configuration 
Stockit controls multi-user access to the database with user names that 
you (or your administrator) set up in the database itself. Some names are 
built into the database as shipped, but you can add others as you need 
them. 

Each user has a user name and password, and also belongs to a ‘group’. 
Each group has a set of ‘permissions’ listing what areas of the 
application or database they can access. 

If you are running a single-user configuration, it is still a good idea to 
keep your program (and database) password-protected. 

All user configuration is done through the Options dialog on the Tools 
menu. 

Groups 
Groups are used to group together users who all need the same access 
permissions to the database. You can either use the built-in groups 
(modifying their permissions as necessary), or create your own. 

Users 
Each user who needs to log into Stockit should have a user name. This 
will allow you to more easily track which users are currently logged into 
the system at any one time (see “Active Users” below). As with groups, 
there are some built-in users already in the database when first installed. 
You can use those users if you want, or create your own. 

Note: The ‘admin’ user cannot be removed, to prevent you getting ‘locked out’ 
accidentally by having no users with administrator permissions. 

Login options 
Various login options are available on the Login and Security page of 
the Options dialog. 

If running in a multi-user configuration, the checkbox ‘Anonymous 
Login’ should be cleared. If this option is set, then the first user starting 
the program will automatically be logged into the database as user 
“admin”. Second and subsequent users will then be unable to access the 
database. 
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Depending on how secure you wish your system to be, passwords are 
optional in Stockit. You can have user names for each of your users so 
that you know who is logged in at any time, but you can if you wish 
allow them to log in without specifying a password. 

Active Users 
You can find out which users are currently logged into the database at 
any time by choosing Options from the Tools menu, and selecting the 
Active Users page on the options dialog. 

This list shows you the user name of all users currently logged into the 
database. You might need this information, for example, if you need to 
upgrade the system, restore a previous version of the database, or carry 
out any other administrative task that requires ‘exclusive’ access to the 
database. Knowing who’s logged in will help you get everyone to log 
out! 
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Chapter 14. Upgrading Your Existing 
System 

This chapter covers upgrades from earlier Number One Systems stock 
control products, Stockit and Stockit Professional DOS, and Stockwin. It 
also provides information on upgrading an existing Stockit for Windows 
installation (see “Updating an existing installation” on page 140). 

General points 
The main decision that you will need to take when importing your 
Stockit DOS or Stockwin database into Stockit is 'how much to import'. 
Although Stockit can import virtually all of the information from the 
earlier products, not all the tables can necessarily be "re-built" in their 
original form. 

The most important point to consider, is whether or not you really want 
your new Stockit database loaded up with historical purchase and 
production information, or whether you just want to work with your 
current information. 

The best method will depend on individual circumstances, whether or 
not you are actually running ‘live’ production jobs through the old 
system, and so on. 

We recommend that where possible you use your current software to 
finish ‘live’ production jobs and purchase orders, and only import your 
stores information into Stockit. These can happen in parallel if 
necessary, as you can always re-import later on to update stock levels 
once all your outstanding deliveries have been booked in and any current 
work in progress is completed. This is the sequence that is documented 
in the step-by-step procedures outlined below. 

Stockit (DOS) users 
This section will help users of the Stockit and Stockit Professional DOS-
based products move their existing stock databases to Stockit for 
Windows. In this section, it is important to remember that "Stockit" 
means "Stockit for Windows", and "Stockit DOS" refers to the Stockit or 
Stockit Professional DOS-based products. 

Preparation 
Although Stockit won't modify any of your existing Stockit DOS files, it 
is a sensible precaution - as with any software - to take a full backup of 
your current data files before starting. 
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Key differences 
Stock - there is no differentiation in Stockit between products, sub-
products, assemblies and sub-assemblies. 

Production - Stockit largely follows the production principles of Stockit 
Professional rather than Stockit DOS. If you are not sure of the 
implications of this, please refer to your Stockit DOS manual. 

Importing the data 
The steps below outline the recommended procedure for importing your 
data. If your requirements are different to those described here, the 
Import Wizard has a variety of options to allow you to adjust the way 
that the import process operates. 

1. From the File menu, choose Import, then Stockit DOS or 
StockPro (both use the same import process). 

2. Click Yes if prompted about closing open forms. 

3. When the Import Wizard starts, click Next.

4. Choose ’Complete Stockit/Stockit Professional Database’, 
and click Next.

5. Specify the location of your database and parts list files. Use 

the  “…” buttons if necessary to browse to the correct 
location. Click Next when the settings are correct. 

6. Choose 'Selected Records', set the checkbox for ‘Stores’,  
clear the other checkboxes, and click Next.

7. Set the checkboxes 'Create Report', 'View Report', and 'Only 
if Errors'. If you wish to include a list of records imported in 
the import report, set the checkboxes for 'Added Records' 
and 'Updated Records'. Change the name or location of the 
report file if you wish. Click Next.

8. Choose 'Empty Database First', clear the checkbox ‘Zero 
stock levels’ and click Next. 

9. Click Finish to finish entering settings and start the import 
process. 

10. When the import process has finished, the report will open if 
there are errors. If no errors occurred, proceed to step 13. 

11. If there were errors, review the report and decide whether 
they need to be fixed. If they can be ignored, click Keep 
Import Results and proceed to step 13. 
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12. Click Cancel Import, return to your Stockit DOS program 
to fix the errors, and re-start the import at step 1. 

13. From the Tools menu, choose Backup. Enter ’Import 
Results’ as the file name to which the backup should be 
written, and press Save.

14. Copy the backup file to floppy disk or your normal backup 
medium and store in a safe place.  

Stockwin users 
This section will help users of the Stockwin Windows-based product 
move their existing stock databases to Stockit for Windows.  

Preparation 
Although Stockit won’t modify any of your existing Stockwin files, it is 
a sensible precaution - as with any software - to take a full backup of 
your current data files before starting. 

Key differences 
Stock - there is no differentiation in Stockit between products, sub-
products, assemblies and sub-assemblies. 

Importing the data 
The steps below outline the recommended procedure for importing your 
data. If your requirements are different to those described here, the 
Import Wizard has a variety of options to allow you to adjust the way 
that the import process operates. 

1. From the File menu, choose Import, then Stockwin. 

2. Click Yes if prompted about closing open forms. 

3. When the Import Wizard starts, click Next.

4. Choose ’Complete Stockwin Database’, and click Next.

5. Specify the location of your database, orders, production and parts 

list files. Use the “…” buttons if necessary to browse to the correct 
location. Click Next when the settings are correct. 

6. Choose 'Selected Records', set the checkbox for ‘Stores’,  clear the 
other checkboxes, and click Next.

7. Set the checkboxes 'Create Report', 'View Report', and 'Only if 
Errors'. If you wish to include a list of records imported in the 
import report, set the checkboxes for 'Added Records' and 'Updated 
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Records’. Change the name or location of the report file if you wish. 
Click Next.

8. Choose 'Empty Database First', clear the checkbox ‘Zero stock 
levels’ and click Next. 

9. Click Finish to finish entering settings and start the import process. 

10. When the import process has finished, the report will open if there 
are errors. If no errors occurred, proceed to step 13. 

11. If there were errors, review the report and decide whether they need 
to be fixed. If they can be ignored, click Keep Import Results and 
proceed to step 13. 

12. Click Cancel Import, return to your Stockwin program to fix the 
errors, and re-start the import at step 1. 

13. From the Tools menu, choose Backup. Enter 'Import Results' as the 
file name to which the backup should be written, and press Save.

14. Copy the backup file to floppy disk or your normal backup medium 
and store in a safe place.  

Updating an existing installation 
If you already have Stockit for Windows installed, updating is very 
simple, regardless of whether you are running in a single-user or multi-
user configuration. 

The step-by-step procedure is shown here: 

1. If running in a multi-user configuration, get all the other users to 
close the Stockit application. 

2. From the File menu, choose Backup and take a backup copy of 
your current Stockit database. If you follow this update procedure 
then you will not lose any database information, but this is a 
sensible precaution anyway when updating any software product. 

3. Insert your latest Stockit CD. 

4. From the opening screen, choose Stockit for Windows (as you did 
when you first installed the product) and press Enter.

5. Follow the steps of the Setup Wizard until you reach the 
Installation Type page, when you should select ‘Single/First User’. 

6. Continue to the next page of the Setup Wizard, the Select 
Components page. At this page, turn off the checkbox for 
‘Database’. The rest of the items should be left checked, so that the 
program and online help files can be updated. 
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7. If you do accidentally leave the ‘Database’ checkbox set, you will 
be reminded in a later step that a database file already exists and 
asked to confirm over-writing it. 

8. Continue with the rest of the Setup Wizard to complete the 
installation. 

9. When installation is complete, start the application and log in as a 
user with ‘permission to maintain the database’. As you log in, you 
may see a “progress” message box appear on the screen for a short 
while as any necessary amendments to the structure of your 
database are carried out. 

10. Use the Backup option to take another backup of the up-to-date 
version of your database. Use a different file name to the one you 
saved in step 2. 

11. Your new version of Stockit is now ready to use! 
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Chapter 15. Trouble-shooting 

Installation 
There are generally very few problems with installation, but some of the 
possible issues are listed below. 

• Application still running: you will need to close down any copies of 
Stockit that are still running. You cannot install the software or 
database when these are still in use. 

• Microsoft “Jet” database engine in use: Stockit uses this database 
engine as the means of interacting with the database file itself. If 
any other applications such as Microsoft Access are currently 
running, the Stockit Setup program may not be able to install or 
update necessary system files. 

Logging in 
If some part of the software has failed for any reason, causing the Stockit 
application to quit without closing ‘normally’, then your user name will 
be left marked as ‘logged in’ in the database. This situation can be fixed 
as follows: 

If running in a multi-user configuration, all users need to log out or quit 
the Stockit application. 

From the Start menu on your Windows taskbar, choose Programs, then 
Stockit for Windows, and finally Stockit for Windows (Recover).

Once the login dialog appears, you can log in as normal and resume 
working. 

Locking 
As described in the section “Locking” on page 133, it is possible that for 
some reason an item remains locked when it should have been released. 
The procedure for recovering from this is the same as described in the 
previous section “Logging in”. 
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Appendix A.  Glossary 
Glossary of terms 

Assemblies – These are anything which require a parts list in their own 
right. It may be a product or sub-product (which could call up 
components, sub-products and sub-assemblies); it may be a sub-
assembly that could call up sub-products, sub-assemblies and 
components, or it may be a specially made component that - although 
brought in as a single item - requires a parts list to properly define it. 

Assembly List - information for assembling the product; it is also used 
to provide a guide to the location of components of the same type. 

Backup - the term applied to the process of taking a complete copy of a 
defined quantity of data. In the case of Stockit this would be the 
complete stock database. This 'copy' is normally stored separately from 
the original as a precaution against hardware failure, equipment theft, or 
other accidental loss or damage. The process of recovering the 
information from this copy is known as Restoring. 

Category - a name or label that is used to identify stock items that are of 
a similar type or otherwise belong together in the same 'group'. 

Components - standard parts that are bought in and used without further 
work or modification. 

Database – a disk file containing information that is organised in a 
structured fashion, usually with relationships between areas of the data. 

Description – a name that is used to best describe an item in the 
database. Where two stock items have a very similar part number, a 
concise description could be all that really makes it possible to easily 
identify which is which. 

Job - a batch of assemblies or products that are handled or grouped 
together. 

MDI – Multiple Document Interface - the ability to view and access 
many forms or windows within the main application window. 

Minimum Level – This is the lowest level that the stock item is allow to 
go to until it must be re-ordered from the supplier. 

Non-Production Order - a purchase order placed on a supplier, where 
the order has not been generated to satisfy a production shortage. 

Part Number - a name that uniquely identifies a stock item. 

Parts List - a collection of items that documents the design of a product 
or assembly, and defines all the parts used. 
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Picking List - a listing used to collect from stores all the components 
that are needed for a particular task. 

Restore - see Backup. 

Trial Kitting – checking stock implications for a planned production 
job, to see which stock items (if any) are not available from stock. 

Tree Structure – a diagrammatic representation of the way parts lists 
are nested one inside another. 

Unplanned Issues – stock items that need to be booked out from stores 
for unforeseen reasons (such as replacement of damaged components). 
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new, 65, 104 

K

Keyboard keys, 34 

L
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Locking, 133 
Login, 30 
Login options, 135 

M

Message window, 34 
Microsoft Access, 17 
Mix of products, 66 
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Navigation bar, 33 
Network, 133 
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New job, 65 
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Online help, 36, 39 
Operating systems, 19 
Orders 

cancelling, 97 

editing order form, 88 

entering items, 86 

non-production, 85 

placing order, 89 

pre-ordering, 116 

over-deliveries, 94 

P

partial deliveries, 94 
Parts List, 59 

editing, 100 

new, 99 
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costs, 120 

passwords, 24 
patches, 20 
Picking List, 48 
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Prompt window, 34 
Purchasing, 85 

Q
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queries, 18 
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Record Selector, 55, 75 
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adjustments, 96 

replenishment, 90 

valuation, 121 

Stock components, 52, 78 
Stock levels, 80 
Stockit (DOS), 137 
Stockwin, 139 
Suggested reading, 14 
Suppliers, 59, 76 
System requirements, 19 

T

tables, 18 
Technical Support, 27 
Time, 82 
Toolbars, 32 

docking, 32 

floating, 33 

tutorial database, 18 
Tutorial Database, 39 

U

Uninstall, 26 
Uninstalling, 26 
Units, 79 
Unrestricted, 81, 82 
Updates, 140 
Upgrading, 26, 137 
Users, 135 

V

Valuation, 121 

W

Where used, 63, 101 
Work in progress, 71, 114 
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